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Product notice

This guide describes features that are common 
to most models. Some features may not be 
available on your computer.

Not all features are available in all editions of 
Windows 8. Your computer may require 
upgraded and/or separately purchased 
hardware, drivers, and/or software to take full 
advantage of Windows 8 functionality. See 
http://www.microsoft.com for details.
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Important Notice about Customer Self-Repair Parts

CAUTION: The computer includes Customer Self-Repair parts and parts that should only be accessed by an 
authorized service provider. See Chapter 5, "Removal and replacement procedures for Customer Self-Repair 
parts," for details. Accessing parts described in Chapter 6, "Removal and replacement procedures for 
Authorized Service Provider only parts," can damage the computer or void the computer warranty.
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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not place 
the computer directly on your lap or obstruct the computer air vents. Use the computer only on a hard, flat 
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as 
pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft 
surface, such as pillows or rugs or clothing, during operation. The computer and the AC adapter comply with 
the user-accessible surface temperature limits defined by the International Standard for Safety of 
Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP ZBook 17 G2 Mobile Workstation

Processors ● Intel® Core™ i7-4940MX 3.10-GHz (SC turbo up to 4.00-GHz) processor (1600-MHz FSB, 8.0-MB L3 
cache, quad core, 8 threads, 57-W)

● Intel Core i7-4910MQ 2.90-GHz (SC turbo up to 3.90-GHz) processor (1600-MHz FSB, 8.0-MB L3 
cache, quad core, 8 threads, 47-W)

● Intel Core i7-4810MQ 2.80-GHz (SC turbo up to 3.80-GHz) processor (1600-MHz FSB, 6.0-MB L3 
cache, quad core, 8 threads, 47-W)

● Intel Core i7-4710MQ 2.50-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz FSB, 6.0-MB L3 
cache, quad core, 8 threads, 47-W)

● Intel Core i7-4610M 3.00-GHz (SC turbo up to 3.70-GHz) processor (1600-MHz FSB, 4.0-MB L3 cache, 
dual core, 4 threads, 37-W)

● Intel Core i5-4340M 2.90-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz FSB, 3.0-MB L3 cache, 
dual core, 4 threads, 37-W)

● Intel Core i5-4210M 2.60-GHz (SC turbo up to 3.20-GHz) processor (1600-MHz FSB, 3.0-MB L3 cache, 
dual core, 4 threads, 37-W)

Chipset Mobile Intel QM87 chipset

Graphics Support for the following graphics subsystem boards (all feature OpenGL driver support, hybrid 
(switchable) graphics, DisplayPort 1.2, up to 4 total displays (through APR), and NVIDIA Mosaic 
Technology):

● NVIDIA Quadro K610M, N15E-Q2, 1 GB dedicated GDDR5 video memory

● NVIDIA Quadro K3100M, N15E-Q1, 4 GB dedicated GDDR5 video memory

● NVIDIA Quadro K4100M, N15E-Q3, 4 GB dedicated GDDR5 video memory

● NVIDIA Quadro K5100M, N15E-Q5, 8 GB dedicated GDDR5 video memory

Display All displays are 16:9 aspect ratio, 7.2-mm, wedge design, low-voltage differential signalling (LVDS) panels

● 17.3-in, high definition plus (HD+), 1600×900, Anti-Glare (AG), light-emitting diode (LED), SVA, with 
or without webcam

● 17.3-in, full high definition (FHD), 1920×1080, AG, LED, WVA, with or without webcam

Memory 4 customer-accessible/upgradable memory module slots

 Supports dual-channel memory

 Supports up to 32,768 MB of system RAM

 DDR3L 1600-MHz PC3-12800 SODIMMs

 Supports the following configurations:

● 32768 MB total system memory (8192 x 4); only available on computer models equipped with a 
quad-core processor

● 16384 MB total system memory (8192 x 2)

● 16384 MB total system memory (4096 x 4); only available on computer models equipped with a 
quad-core processor
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Memory (continued) Supports the following configurations:

● 12288 MB total system memory (8192 + 4096)

● 8192 MB total system memory (8192 × 1)

● 8192 MB total system memory (4096 × 2)

● 4096 MB total system memory (4096 × 1)

● 4096 MB total system memory (2048 × 2)

● 2048 MB total system memory (2048 × 1)

Mini card SSD 128 GB

Primary storage Supports 7.0 mm (0.28 in) or 9.5 mm (0.37 in), 6.35 cm (2.5 in) hard drives and 6.35 cm (2.5 in) solid-state 
drive for primary and secondary storage.

 Supports 3D DriveGuard

 Supports toolless remove mechanism

 Supports the following Serial ATA (SATA) drives:

● 1-TB, 7200-RPM, SATA, 9.5-mm

● 1-TB, 5400-RPM, SATA, 7.0-mm

● 750-GB, 7200-RPM, SATA, 7.0-mm

● 500-GB, 7200-RPM, SATA, 7.0-mm

● 500-GB, 7200-RPM, self-encrypting drive (SED), 7.0-mm

● 500-GB, 5400-RPM, SATA, FIPS, 7.0-mm

 Supports the following 6.35 cm (2.5 in), solid-state drives (SSD):

● 512 GB, SATA-3

● 256 GB, SATA-3, SED, Opal2

● 256 GB, SATA-3, SED, Opal1

● 256 GB, SATA-3

● 240 GB, SATA-3

● 180 GB, SATA-3

● 128 GB, SATA-3

Secondary storage Supports 7.0 mm (0.28 in) or 9.5 mm (0.37 in), 6.35 cm (2.5 in) hard drives and 6.35 cm (2.5 in) solid-state 
drive for primary and secondary storage.

 Supports the following SATA drives:

● 1-TB, 7200-RPM, SATA, 9.5-mm

● 1-TB, 5400-RPM, SATA, 7.0-mm

● 750-GB, 7200-RPM, SATA, 7.0-mm

● 500-GB, 7200-RPM, SATA, 7.0-mm

● 500-GB, 7200-RPM, SED, 7.0-mm

● 500-GB, 5400-RPM, SATA, FIPS, 7.0-mm

 Supports the following 6.35 cm (2.5 in), solid-state drives (SSD):
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Category Description

Secondary storage 
(continued)

● 512 GB, SATA-3

● 256 GB, SATA-3, SED, Opal2

● 256 GB, SATA-3, SED, Opal1

● 256 GB, SATA-3

● 240 GB, SATA-3

● 180 GB, SATA-3

● 128 GB, SATA-3

Upgrade bay Support for RAID 0/1/5

 Supports 7.0 mm (0.28 in) or 9.5 mm (0.37 in) hard drives:

● 750 GB, 5400 rpm

● 512 GB SATA III SSD

● 256 GB SATA III SSD, SED

 Supports the following 9.5 mm (0.37 in) SATA optical drives:

● Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

● Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

● DVD±RW SuperMulti Double-Layer Drive

 Supports no drive option

Audio and video Integrated dual-array microphone

 High-definition (HD) audio with DTS Studio Sound

 2 stereo speakers

 Integrated 720p HD webcam

 Supports no camera option

Ethernet Intel I217-LM Gigabit Network Connection

 Power optimizer support

 Intel Stable Image Platform Program (SIPP)

 Ethernet cable not included

Wireless Integrated wireless local area network (WLAN) options by way of the following wireless modules:

● WLAN Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi + Bluetooth 4.0 Combo Adapter

● WLAN Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 Combo Adapter

● WLAN Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 Combo Adapter

● WLAN Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n 2×2 WiFi adapter

 WLAN antennas (2) built into display assembly

 Support for no WLAN option

 Integrated wireless wide area network (WWAN) options by way of the following wireless modules: (not 
available on computer models with Dream Color displays)

● HP lt4211 LTE/EV-DO/HSPA+ 4G Module
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Wireless (continued) ● HP lt4112 LTE/HSPA+ Mobile Broadband Module

● HP hs3110 HSPA+ Mobile Broadband Module

 WWAN antennas (2) built into display assembly

 Support for no WWAN option

 Security provided by subscriber identify module (SIM) card

External media card One ExpressCard slot, 54 mm

 Integrated SD UHS-II flash media slot

 Supports next generation SD (Secure Digital). Backward compatible with SDHC, SDXC.

Ports Multi-pin AC port

Combo mic-in/Stereo headphone jack

DisplayPort 1.2

Mini DisplayPort with pass through DP 1.2 support

Docking connector

Secondary battery connector

RJ-45 (Ethernet, includes link and activity lights)

USB 3.0 (3)

USB 2.0 (1)

USB 3.0 charging port (1)

VGA (Dsub 15-pin) supporting 1920 × 1200 external resolution at 75 GHz (hot plug/unplug with auto-
detect)

Docking Supports the following docking stations:

● HP Docking Station

● HP Advanced Docking Station

Keyboard/pointing 
devices

Full sized, backlit or non-backlit, chiclet (island-style) keyboard with separate numeric keypad:

 Spill-resistant with drain

 Dura Keys

 Touchpad includes DuraPad coating; glass with chemical etched surface; image sensor

 Gestures enabled by default - 2 finger scrolling, 2 finger zoom (pinch)

 Touchpad supports two-way scroll with legend

 Taps enabled as default

Power requirements Supports the following AC adapters with localized cable plug support:

● 230W HP Smart AC adapter

● 200W HP Smart AC adapter

● 3-wire plug (with ground pin)

 Support for the following batteries:
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Power requirements 
(continued)

● 8-cell, 2.80-AHr, 83-WHr, Li-ion battery

● 8-cell, 2.80-AHr, 75-WHr, Li-ion battery

Security Integrated fingerprint reader

Integrated Smart Card reader

Preboot authentication (password, Smart Card)

Supports security lock

Trusted platform module (TPM) v.1.2 and TPM enhanced drive lock

Operating system Preinstalled operating systems

Windows 10:

● Windows 10 Home 64-bit Chinese Market CPPP

● Windows 10 Home 64-bit High-End

● Windows 10 Home 64-bit High-End Single Language

● Windows 10 Home 64-bit High-End Chinese Market (supported in the People’s Republic of China)

● Windows 10 Professional 64-bit

● Windows 10 Professional 64-bit downgradable to Windows 7 64-bit

Windows 8

● Windows 8.1 Professional 64-bit DPK with Windows 7 Professional 64-bit image

● Windows 8.1 Professional 64-bit DPK with Windows 7 Professional 64-bit image MSNA

● Windows 8.1 Professional 64-bit

● Windows 8.1 Professional 64-bit MSNA

● Windows 8.1 Professional 64-bit for Education

● Windows 8.1 Emerging Markets 64-bit (not available on computer models equipped with an Intel i7 
processor and more than 4.0-GB system memory or on computer models equipped with an FHD 
display assembly and more than or equal to 8.0-GB system memory)

● Windows 8.1 Multilanguage 64-bit (not available on computer models equipped with an Intel i7 
processor and more than 4.0-GB system memory or on computer models equipped with an FHD 
display assembly and more than or equal to 8.0-GB system memory)

● Windows 8.1 Chinese 64-bit (supported only in the People’s Republic of China; not available on 
computer models equipped with an Intel i7 processor and more than 4.0-GB system memory or on 
computer models equipped with an FHD display assembly and more than or equal to 8.0-GB system 
memory)

● Windows 8.1 Chinese 64-bit CPPP (supported only in the People’s Republic of China)

● Windows 8.1 Emerging Marketing 64-bit Home High End (available only on computer models 
equipped with an Intel i7 processor and more than 4.0-GB system memory or on computer models 
equipped with an FHD display assembly and more than or equal to 8.0-GB system memory)

● Windows 8.1 Multilanguage 64-bit Home High End (available only on computer models equipped 
with an Intel i7 processor and more than 4.0-GB system memory or on computer models equipped 
with an FHD display assembly and more than or equal to 8.0-GB system memory)

Windows 7

● Windows 7 Professional 64-bit

● Windows 7 Professional 64-bit MSNA
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Operating system 
(continued)

Preinstalled operating systems (continued)

Non-Windows operating systems

● FreeDOS 2.0

● Novell™: SuSE Linux™ – SLED 11, 64-bit, SP2 (not available in models with WWAN or Blu ray drives)

Restore media:

DRDVD:

● DRDVD Windows 10 (available with any Windows 10 loc, required with any Windows 10 Professional 
downgrade OS)

● DRDVD Windows 8.1 (available with any Windows 8.1 loc, required with any Windows 8.1 
Professional downgrade OS)

● DRDVD Windows 7, Service Pack 1 (available with any Windows 10, Windows 8.1, or Windows 7 
Professional downgrade loc)

● SRDVD (available with Unbuntu Linux operating system)

OSDVD:

● Windows 8.1 64-bit (for service only)

● Windows 8.1 Country-specific 64-bit (for service only)

● Windows 8.1 Emerging Market 64-bit (for service only)

● Windows 8.1 Professional 64-bit (only available and required with Windows 8.1 downgrade 
operating system, not available in Asia Pacific countries or regions and the People’s Republic of 
China)

● Windows 7 Professional 64-bit, Service Pack 1 (available with any Windows 10, Windows 8.1, or 
Windows 7 Professional Downgrade, except in Asia Pacific countries or regions and the People’s 
Republic of China)

Certified: Microsoft WHQL

Web-only support:

● Windows 10 Enterprise

● Windows 8.1 Enterprise 64-bit

● Windows 7 Ultimate 64-bit, Service Pack 1

● Windows 7 Ultimate 32-bit, Service Pack 1

● Windows 7 Enterprise 64-bit, Service Pack 1

● Windows 7 Enterprise 32-bit, Service Pack 1

● Windows 7 Professional 32-bit, Service Pack 1

Serviceability End-user replaceable parts:

● Memory module

● Optical drive

● Hard drive/SSD

● Battery

● AC adapter

Serviceability 
(continued)

● Keyboard

● WLAN module
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● WWAN module

● mSATA
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2 External component identification

Display

Component Description

(1) WLAN antennas (2)* (select models only) Send and receive wireless signals to communicate with WLANs.

(2) WWAN antennas (2)* (select Windows 
models only)

Send and receive wireless signals to communicate with WWANs.

(3) Internal microphones (2) Record sound.

(4) Webcam light (select models only) On: The webcam is in use.

(5) Webcam (select models only) Records video and captures still photographs.

For information on using the webcam:

● Windows 10 – Type camera in the taskbar search box, and 
then select Camera.

● Windows 8 – Access HP Support Assistant. To access HP 
Support Assistant on the Start screen, select the HP Support 
Assistant app.

● Windows 7 – Select Start > All Programs > Communication 
and Chat > HP WebCam.

(6) Internal display switch Turns off the display or initiates Sleep (Windows)/Suspend (Linux) if 
the display is closed while the power is on.
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NOTE: The display switch is not visible on the outside of the 
computer.

*The antennas are not visible on the outside of the computer. For optimal transmission, keep the areas immediately around the 
antennas free from obstructions.

For wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental Notices that applies to your country or 
region.

To access this guide:

Windows 10:

1. Type support in the taskbar search box, and then select the HP Support Assistant app.

– or –

Click the question mark icon in the taskbar.

2. Select My PC, select the Specifications tab, and then select User Guides.

Windows 8 or Windows 7:

▲ Select the HP Support Assistant app on the Start screen, select My computer, and then select User guides.

Buttons and speakers

Component Description

(1)  Power button ● When the computer is off, press the button to turn on the 
computer.

● When the computer is on, press the button briefly to initiate 
Sleep (Windows)/Suspend (Linux).

Buttons and speakers 9



Component Description

● When the computer is in the Sleep state, press the button 
briefly to exit Sleep (Windows)/Suspend (Linux).

● When the computer is in Hibernation, press the button briefly 
to exit Hibernation.

CAUTION: Pressing and holding down the power button will result 
in the loss of unsaved information.

If the computer has stopped responding and operating system 
shutdown procedures are ineffective, press and hold the power 
button for at least 5 seconds to turn off the computer.

To learn more about your power settings:

Windows 10: Type power in the taskbar search box, and then select 
Power and sleep settings.

– or –

Right-click the Start button, and then select Power Options.

Windows 8: See your power options. From the Start screen, type 
power, select Settings, and then select Power Options.

Windows 7: See your power options. Select Start > Control Panel > 
System and Settings > Power Options.

Linux:

1. Select Computer > Control Center.

2. In the left pane, click System, and then click Power 
Management in the right pane.

(2)  Speakers (2) Produce sound.

(3)  Wireless button Turns the wireless feature on or off but does not establish a 
wireless connection.

(4)  Volume mute button Mutes and restores speaker sound.

(5)  Fingerprint reader Allows a fingerprint logon to the operating system, instead of a 
password logon.
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Keys

Component Description

(1)  esc key

NOTE: Windows models only.

Displays system information when pressed in combination with the 
fn key.

(2)  fn key Executes frequently used system functions when pressed in 
combination with a function key, the num lk key, the esc key, or the 
b key.

(3)  Windows key

NOTE: Windows 10 models only.

Opens the Start menu.

NOTE: Pressing the Windows key again will close the Start menu.

(3)  Windows button 

NOTE: Windows 8 and Windows 7 models 
only.

Windows 8:

Returns you to the Start screen from an open app or the Windows 
desktop.

NOTE: Pressing the Windows button again will return you to the 
previous screen.

Windows 7:

Displays the Windows Start menu.

(4)  Function keys Execute frequently used system functions when pressed in 
combination with the fn key.

(5)  num lk key Windows 10 and Windows 8:

Turns the embedded numeric keypad on and off when pressed in 
combination with the fn key. Alternates between the navigational 
and numeric functions on the integrated numeric keypad.

Windows 7 and Linux:

Alternates between the navigational and numeric functions on the 
integrated numeric keypad.

(6)  Integrated numeric keypad When num lk has been enabled, it can be used like an external 
numeric keypad.
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Lights

Component Description

(1)  Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows) or 
Suspend state (Linux).

● Off: The computer is off.

(2)  Caps lock light On: Caps lock is on.

(3)  TouchPad light ● Amber: The TouchPad is off.

● Off: The TouchPad is on.

(4)  Microphone mute light ● Amber: microphone sound is off.

● Off: microphone sound is on.

(5)  Num lock light On: Num lock is on.

(6)  Wireless light ● White: An integrated wireless device, such as a WLAN device 
and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(7)  Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

12 Chapter 2   External component identification



TouchPad

Component Description

(1)  Pointing stick Moves the pointer and selects or activates items on the screen.

(2)  Left pointing stick button Functions like the left button on an external mouse.

(3)  Touchpad on/off button Turns the Touchpad on and off.

(4)  Touchpad zone Moves the pointer and selects or activates items on the screen.

(5)  Left TouchPad button Functions like the left button on an external mouse.

(6)  Right pointing stick button Functions like the right button on an external mouse.

(7)  Center pointing stick button Functions like the center button on an external mouse.

(8)  Center TouchPad button Functions like the center button on an external mouse

(9)  Right TouchPad button Functions like the right button on an external mouse.
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Front

Component Description

(1)  Wireless light ● White: An integrated device, such as a WLAN device and/or a 
Bluetooth device, is on.

● Amber: All wireless devices are off.

(2)  Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off.

(3)  AC adapter/Battery light ● White: The computer is connected to external power and the 
battery is charged from 90 to 99 percent.

● Amber: The computer is connected to external power and the 
battery is charged from 0 to 90 percent.

● Blinking amber: A battery that is the only available power 
source has reached a low battery level. When the battery 
reaches a critical battery level, the battery light begins blinking 
rapidly.

● Off: The battery is fully charged.

(4)  Hard drive light ● Blinking white: The hard drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the hard 
drive.
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Left

Component Description

(1)  Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but it 
may not prevent the computer from being mishandled or stolen.

(2)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal 
components and prevent overheating. It is normal for the internal 
fan to cycle on and off during routine operation.

(3)  USB 2.0 port Connects an optional USB device.

(4)  DisplayPort Connects an optional digital display device, such as a high-
performance monitor or projector.

(5)  Thunderbolt port

NOTE: Windows models only.

Connects an optional high-resolution display device or a high-
performance data device.

NOTE: Thunderbolt is new technology. Install all the latest drivers 
for your Thunderbolt device before connecting the device to the 
Thunderbolt port. Thunderbolt cable and Thunderbolt device (sold 
separately) must be compatible with Windows. To determine 
whether your device is Thunderbolt Certified for Windows, see 
https://thunderbolttechnology.net/products.

(6)  USB 3.0 charging port Connects optional USB 3.0 devices and provides enhanced USB 
power performance. The USB charging port can also charge select 
models of cell phones and MP3 players, even when the computer is 
off.

(7)  Smart card Support optional smart cards.

(8)  ExpressCard slot or smart card reader 
(depending on the configuration)

Supports optional ExpressCards or smart cards.
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Right

Component Description

(1)  Memory card reader Reads data from and writes data to memory cards such as Secure 
Digital (SD).

(2)  Audio-out (headphone) jack/Audio-in 
(microphone) jack

Produces sound when connected to optional powered stereo 
speakers, headphones, earbuds, a headset, or television audio. Also 
connects an optional headset microphone.

WARNING! To reduce the risk of personal injury, adjust the volume 
before putting on headphones, earbuds, or a headset. For additional 
safety information, see the Regulatory, Safety, and Environmental 
Notices. To access the user guides in Windows 8, select the HP 
Support Assistant app on the Start screen, select My computer, and 
then select User guides. To access the user guides in Windows 7, 
select the HP Support Assistant app on the Start screen, select My 
computer, and then select User guides.

NOTE: When a device is connected to the jack, the computer 
speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor connector 
that supports both audio-out (headphone) and audio-in 
(microphone).

(3)  USB 3.0 ports (2) Connect optional USB 3.0 devices and provide enhanced USB power 
performance.

(4)  Optical drive (select models only) Reads and/or writes, depending on your computer model, to an 
optical disc.

(5)  Optical drive eject button (select models 
only)

Releases the optical drive disc tray.
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Rear

Component Description

(1)  RJ-45 (network) jack Connects a network cable.

(2)  Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal 
components and prevent overheating. It is normal for the internal 
fan to cycle on and off during routine operation.

(3)  Power connector Connects an AC adapter.

(4)  AC adapter lights ● White: The computer is connected to external power.

● Off: The computer is not connected to external power.
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Bottom

Component Description

(1)  Battery release latch Releases the battery.

(2)  Battery bay Holds the battery.

(3)  SIM slot

NOTE: Select Windows models only.

Supports a wireless subscriber identity module (SIM). The SIM slot is 
located inside the battery bay.

(4)  Docking connector Connects an optional docking device.

(5)  Accessory battery connector Connects an optional accessory battery.

(6)  Service cover release lock Locks service cover.

(7)  Service cover release latch Releases the service cover on the computer.

(8)  Vents (3) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal 
components and prevent overheating. It is normal for the internal 
fan to cycle on and off during routine operation.

(9)  Service cover Provides access to the hard drive bay, the WLAN module slot, the 
WWAN module slot, and the memory module slots.
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Component Description

CAUTION: To prevent an unresponsive system, replace the 
wireless module only with a wireless module authorized for use in 
the computer by the governmental agency that regulates wireless 
devices in your country or region. If you replace the module and then 
receive a warning message, remove the module to restore computer 
functionality, and then contact support through HP Support 
Assistant. To access HP Support Assistant in Windows 8, on the Start 
screen, select the HP Support Assistant app. To access Help and 
Support in Windows 7, select Start > Help and Support.
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3 Illustrated parts catalog

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then 
follow the on-screen instructions.

Service tag
When ordering parts or requesting information, provide the computer serial number and model number 
provided on the service tag.

NOTE: The computer service labels will resemble one of the examples shown in this section. Refer to the 
illustration that most closely matches the service label on the computer.

Item Component Description

(1) Product name This is the product name affixed to the front of the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to each product.
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Item Component Description

(3) Product number (p/n) This number provides specific information about the product’s 
hardware components. The part number helps a service technician 
determine what components and parts are needed.

(4) Warranty period This number describes the duration of the warranty period for the 
computer.

(5) Model number (select models only) This is the alphanumeric identifier needed to locate documents, 
drivers, and support for the computer.

PCID label
The PCID label provides the information required to properly reset the notebook firmware (BIOS) back to 
factory shipped specifications when replacing the system board. The label may have a different number of 
characters depending on the operating system on the computer.

NOTE: Computer details may vary from images.

Windows 8 models
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Non-Windows 8 models
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Computer major components

Item Description Spare part number

(1) Display assembly (includes microphone and wireless antenna cables):

 17.3-in, AG, FHD, LED, UWVA display assembly for use on computer models equipped with a 
webcam

784207-001

 17.3-in, AG, FHD, LED, UWVA display assembly for use on computer models not equipped with 
a webcam

784206-001

 NOTE: See Display assembly components on page 29 for more display component information and spare part 
numbers.
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Item Description Spare part number

(2) Keyboard with backlight, pointing stick, and TouchPad (includes backlight, keyboard, pointing stick, and TouchPad 
cables):

 For use in Belgium 733688-A41

 For use in Brazil 733688-201

 For use in Bulgaria 733688-261

 For use in Canada 733688-DB1

 For use in the Czech Republic and Slovakia 733688-FL1

 For use in Denmark 733688-081

 For use in France 733688-051

 For use in Germany 733688-041

 For use in Greece 733688-151

 For use in Hungary 733688-211

 For use in Iceland 733688-DD1

 For use in India 733688-D61

 For use in Israel 733688-BB1

 For use in Italy 733688-061

 For use in Japan 733688-291

 For use in Latin America 733688-161

 For use in the Netherlands 733688-B31

 For use in Northwest Africa 733688-FP1

 For use in Norway 733688-091

 For use in Portugal 733688-131

 For use in Romania 733688-271

 For use in Russia 733688-251

 For use in Saudi Arabia 733688-171

 For use in Slovenia 733688-BA1

 For use in South Korea 733688-AD1

 For use in Spain 733688-071

 For use in Sweden and Finland 733688-B71

 For use in Switzerland 733688-BG1

 For use in Taiwan 733688-AB1

 For use in Thailand 733688-281

 For use in Turkey 733688-141

 For use in the United Kingdom and Singapore 733688-031

 For use in the United States 733688-001
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Item Description Spare part number

 Keyboard with pointing stick and TouchPad (includes keyboard, pointing stick, and TouchPad cables):

 For use in Belgium 745663-A41

 For use in Brazil 745663-201

 For use in Bulgaria 745663-261

 For use in Canada 745663-DB1

 For use in the Czech Republic and Slovakia 745663-FL1

 For use in Denmark 745663-081

 For use in France 745663-051

 For use in Germany 745663-041

 For use in Greece 745663-151

 For use in Hungary 745663-211

 For use in Iceland 745663-DD1

 For use in India 745663-D61

 For use in Israel 745663-BB1

 For use in Italy 745663-061

 For use in Japan 745663-291

 For use in Latin America 745663-161

 For use in the Netherlands 745663-B31

 For use in Northwest Africa 745663-FP1

 For use in Norway 745663-091

 For use in Portugal 745663-131

 For use in Romania 745663-271

 For use in Russia 745663-251

 For use in Saudi Arabia 745663-171

 For use in Slovenia 745663-BA1

 For use in South Korea 745663-AD1

 For use in Spain 745663-071

 For use in Sweden and Finland 745663-B71

 For use in Switzerland 745663-BG1

 For use in Taiwan 745663-AB1

 For use in Thailand 745663-281

 For use in Turkey 745663-141

 For use in Turkey, F-type keyboard 745663-541

 For use in the United Kingdom and Singapore 745663-031
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Item Description Spare part number

 For use in the United States 745663-001

(3) Top cover 735587-001

(4) Power button board (includes cable) 733636-001

(5) Memory modules (PC3L-12800, 1600-MHz, DDR3L):

 8.0-GB 693374-001

 4.0-GB 691740-001

(6) Fingerprint reader board (includes cable)

NOTE: The fingerprint reader board spare part kit does not include the fingerprint reader 
board bracket. The fingerprint reader board bracket is included in the Bracket Kit, spare part 
number 733637-001.

737730-001

(7) Processor (includes replacement thermal material):

 Intel Core i7-4940MX 3.10-GHz (SC turbo up to 4.00-GHz) processor (1600-MHz FSB, 8.0-MB L3 
cache, quad core, 8 threads, 57-W)

778694-001

 Intel Core i7-4910MQ 2.90-GHz (SC turbo up to 3.90-GHz) processor (1600-MHz FSB, 8.0-MB L3 
cache, quad core, 8 threads, 47-W)

778693-001

 Intel Core i7-4810MQ 2.80-GHz (SC turbo up to 3.80-GHz) processor (1600-MHz FSB, 6.0-MB L3 
cache, quad core, 8 threads, 47-W)

778692-001

 Intel Core i7-4710MQ 2.50-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz FSB, 6.0-MB L3 
cache, quad core, 8 threads, 47-W)

773212-001

 Intel Core i7-4610M 3.00-GHz (SC turbo up to 3.70-GHz) processor (1600-MHz FSB, 4.0-MB L3 
cache, dual core, 4 threads, 37-W)

765141-001

 Intel Core i5-4340M 2.90-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz FSB, 3.0-MB L3 
cache, dual core, 4 threads, 37-W)

765142-001

 Intel Core i5-4210M 2.60-GHz (SC turbo up to 3.20-GHz) processor (1600-MHz FSB, 3.0-MB L3 
cache, dual core, 4 threads, 37-W)

768420-001

(8) Graphics board (includes replacement thermal material):

 AMD FirePro W6170M 786689-001

 NVIDIA K1100M N15P-Q1 785214-001

 NVIDIA Quadro K5100M 781701-001

 NVIDIA Quadro K4100M 781702-001

 NVIDIA Quadro K3100M 781703-001

 NVIDIA Quadro K2200M 786688-001

(9) Multifunction board (includes LED light pipe) 733639-001

(10) System board (includes replacement thermal material):

 For use only on computer models equipped with a quad core processor and the Windows 10 or 
Windows 8 Professional operating systems

784213-601

 For use only on computer models equipped with a quad core processor and the Windows 10 or 
Windows 8 Standard operating systems

784213-501

 For use only on computer models equipped with a quad core processor and a non-Windows 10 
or non-Windows 8 operating systems

784213-001
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Item Description Spare part number

 For use only on computer models equipped with a dual core processor and the Windows 10 or 
Windows 8 Professional operating systems

784212-601

 For use only on computer models equipped with a dual core processor and the Windows 10 or 
Windows 8 Standard operating systems

784212-501

 For use only on computer models equipped with a dual core processor and a non-Windows 10 
or non-Windows 8 operating systems

784212-001

(11) Solid-state drive:

 512 GB, SATA-3 795969-001

 512 GB, SATA-3, SED, Opal2 815841-001

 512 GB, Z Turbo Drive PCIe 815840-001

 256 GB, SATA-3 795966-001

 256 GB, M2, PCIe-2×2 794731-001

 256 GB, SATA-3, Locked 806895-001

 256 GB, SATA-3, SED, Opal2 795968-001

 256 GB, Opal2, Locked 830147-001

 240 GB, SATA-3 795965-001

 180 GB, SATA-3 795964-001

 128 GB, SATA-3 795963-001

 128 GB, Z Turbo Drive PCIe 815839-001

(12) WWAN module:

 HP lt4211 LTE/EV-DO/HSPA+ 4G Module 793116-001

 HP lt4112 LTE/HSPA+ Mobile Broadband Module 740011-001

 HP hs3110 HSPA+ Mobile Broadband Module 748599-001

(13) WLAN module:

 WLAN Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi + Bluetooth 4.0 Combo Adapter 710663-001

 WLAN Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 
Combo Adapter

717379-001

 WLAN Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 
Combo Adapter

747833-001

 WLAN Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n 2×2 WiFi adapter 717380-001

(14) Audio/USB board (includes audio jack and USB port) 737732-001

(15) ExpressCard assembly 794578-001

(16) Speakers (include left and right speakers and cables) 733638-001

(17) Smart Card reader (includes cable) 742159-001

(18) Optical drive for use in Upgrade Bay (includes bezel and bracket):

 Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive 735600-001
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Item Description Spare part number

 Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive 735599-001

 DVD±RW SuperMulti Double-Layer Drive 735602-001

 Upgrade Bay hard drive carrier 734298-001

(19) Graphics subsystem heat sink (includes replacement thermal material):

 For use only on computer models equipped with the NVIDIA Quadro K5100M graphics board 735373-001

 For use only on computer models equipped with the NVIDIA Quadro K4100M or K3100M 
graphics board

735374-001

 For use only on computer models equipped with the MXM-Emerald graphics board 786687-001

 For use only on computer models equipped with the MXM-N15P-15 graphics board 786686-001

 For use only on computer models equipped with the MXM-N15P-Q1 graphics board (includes 
fan)

768730-001

(20) Processor heat sink (includes replacement thermal material):

 For use only on computer models equipped with a quad core processor 735372-001

 For use only on computer models equipped with a dual core processor 735371-001

(21) Battery:

 8-cell, 2.80-AHr, 83-WHr, Li-ion 708456-001

 8-cell, 2.80-AHr, 75-WHr, Li-ion 708455-001

(22) Base enclosure (includes latches) 785211-001

(23) Hard drive:

NOTE: The hard drive spare part kit does not include the hard drive bracket, cover, or screws. The hard drive bracket, 
cover, and screws are included in the Hard Drive Hardware Kit, spare part number 734280-001.

 1-TB, 7200-RPM, SATA, 9.5-mm 766644-001

 1-TB, 5400-RPM, SATA, 7.0-mm 778192-001

 750-GB, 7200-RPM, SATA, 7.0-mm 778191-001

 500-GB, 7200-RPM, SATA, 7.0-mm 703267-001

 500-GB, 7200-RPM, SED, 7.0-mm 703268-001

 500-GB, 5400-RPM, SATA, FIPS, 7.0-mm 730946-001

(24) RTC battery (includes cable and double-sided adhesive) 734300-001

(25) Service cover 733635-001
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Display assembly components
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Item Description Spare part number

(1) Display bezel:

 For use only on computer models equipped with a webcam 733633-001

 For use only on computer models not equipped a webcam 735589-001

(2) Display panel cable: Included in the Cable Kit, spare part number 785212-001 (includes webcam module cable)

 Display Hinge Kit, includes: 733634-001

(3a) Left and right hinges

(3b) Hinge cover

 Hinge brackets (not illustrated)

(4) Webcam/microphone module 784208-001

 Microphone module (not illustrated) 735370-001

(5) Display panel:

 17.3-in, FHD, AG, LED, WVA display panel 735367-001

 17.3-in, HD, AG, LED, WVA display panel 735366-001

 Display Panel Support Kit, includes: 784211-001

(6) WLAN antenna cables and transceivers

(7) WWAN antenna cables and transceivers

(8) Display enclosure (also available using spare part number 740477-001)

 Low-voltage differential signalling board (not illustrated) 741282-001
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Bracket Kit

Item Description Spare part number

 Bracket Kit 737734-001

(1) Power connector/security lock bracket

(2) RJ-45 bracket

(3) Fingerprint reader bracket
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Cable Kit

Item Description Spare part number

 Cable Kit 785212-001

(1) Display panel cable (includes webcam/microphone module cable)

(2) Low-voltage differential signalling board cable

(3) Power connector cable
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Plastics Kit

Item Description Spare part number

 Plastics Kit 733637-001

(1) Rear corner cover/right

(2) Rear corner cover/left

(3) Fingerprint reader bezel

(4) SD Card reader bezel

(5) ExpressCard bezel

 Fingerprint reader cover (not illustrated)
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Mass storage devices

Item Description Spare part number

(1) Solid-state drive:

 512 GB, SATA-3 795969-001

 256 GB, SATA-3, SED, Opal2 795968-001

 256 GB, SATA-3, SED, Opal1 795967-001

 256 GB, SATA-3 795966-001

 240 GB, SATA-3 795965-001

 180 GB, SATA-3 795964-001

 128 GB, SATA-3 795963-001

(2a) Hard Drive Hardware Kit (includes hard drive bracket, cover, and screws) 734280-001

(2b) Hard drive:

NOTE: The hard drive spare part kit does not include the hard drive bracket, cover, or screws. The hard drive bracket, 
cover, and screws are included in the Hard Drive Hardware Kit, spare part number 734280-001.

 1-TB, 7200-RPM, SATA, 9.5-mm 766644-001

 1-TB, 5400-RPM, SATA, 7.0-mm 778192-001

 750-GB, 7200-RPM, SATA, 7.0-mm 778191-001

 500-GB, 7200-RPM, SATA, 7.0-mm 703267-001
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Item Description Spare part number

 500-GB, 7200-RPM, SED, 7.0-mm 703268-001

 500-GB, 5400-RPM, SATA, FIPS, 7.0-mm 730946-001

(3) Optical drive for use in Upgrade Bay (includes bezel and bracket):

 Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive 735600-001

 Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive 735599-001

 DVD±RW SuperMulti Double-Layer Drive 735602-001

 Upgrade Bay hard drive carrier (not illustrated) 734298-001

Miscellaneous parts

Description Spare part number

AC Adapter:

230-W HP Smart AC adapter (PFC) 693706-001

200-W HP Smart AC adapter (PFC) 693708-001

HP professional slim top-load carrying case 703888-001

HP DisplayPort-to-HDMI adapter 749288-001

Upgrade Bay hard drive carrier 734298-001

HP cable lock for use on the docking station 575921-001

HP Ultraslim keyed cable lock 703372-001

HP USB laser mouse 674318-001

Power cord (3-pin, black,1.83-m):

For use in Argentina 491683-D01

For use in Australia 491683-011

For use in Belgium 491683-A41

For use in Brazil 491683-202

For use in the Czech Republic and Slovakia 491683-221

For use in Denmark 491683-081

For use in Europe 491683-021

For use in France 491683-051

For use in Germany 491683-041

For use in Greece 491683-151

For use in India 491683-D61

For use in Israel 491683-BB1

For use in Italy 491683-061
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Description Spare part number

For use in Japan 491683-291

For use in North America 491683-001

For use in the Netherlands 491683-B91

For use in North Africa 491683-DE1

For use in Norway 491683-091

For use in Portugal 491683-131

For use in the People's Republic of China 491683-AA1

For use in Saudi Arabia 491683-171

For use in South Korea 491683-AD1

For use in Sweden and Finland 491683-101

For use in Switzerland 491683-111

For use in Taiwan 491683-AB1

For use in Thailand 491683-201

For use in Turkey 491683-141

For use in the United Kingdom 491683-031

Screw Kit 741619-001
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4 Removal and replacement procedures 
preliminary requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

● 5.0 mm hex socket driver

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly 
and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all accompanying 
screws) away from the work area to prevent damage.

Plastic parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling 
the plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and and pointing stick connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the 
reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or 
seat the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, 
avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be 
caught or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables 
tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the 
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer 
is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid 
touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure 
that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective 
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure 
determine the degree of sensitivity. Networks built into many integrated and pointing stick circuits provide 
some protection, but in many cases, ESD contains enough power to alter device parameters or melt 
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and and pointing stick can work perfectly 
throughout a normal cycle. Or the device may function normally for a while, then degrade in the internal 
layers, reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal components, 
observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described in this 
section.

Avoid touching pins, leads, and pointing stick circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different 
activities.

CAUTION: A product can be degraded by as little as 700 V.
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Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand and pointing stick contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved and pointing stick containers 
or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

● Use transporters and pointing stick conveyors made of antistatic belts and roller bushings. Be sure that 
mechanized equipment used for moving materials is wired to ground and that proper materials are 
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate electric 
charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and 
equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe 
materials.

● Keep the work area free of non conductive materials, such as ordinary plastic assembly aids and 
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these 
items only at static-free workstations.

Grounding guidelines 39



● Avoid and pointing stick contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.

Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a 
minimum of one megohm ±10% resistance in the ground and pointing stick cords. To provide proper 
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug 
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be 
used at standing workstations and are compatible with most types of shoes or boots. On conductive 
floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance 
between the operator and ground. To be effective, the conductive strips must be worn in contact with 
the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground and pointing stick cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Non conductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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5 Removal and replacement procedures for 
Customer Self-Repair parts

CAUTION: The Customer Self-Repair program is not available in all locations. Installing a part not 
supported by the Customer Self-Repair program may void your warranty. Check your warranty to determine 
if Customer Self-Repair is supported in your location.

Component replacement procedures
This chapter provides removal and replacement procedures for Customer Self-Repair parts.

There are as many as 29 screws that must be removed, replaced, or loosened when servicing Customer Self-
Repair parts. Make special note of each screw size and location during removal and replacement.

Battery

Description Spare part number

8-cell, 2.80-AHr, 83-WHr, Li-ion battery 708456-001

8-cell, 2.80-AHr, 75-WHr, Li-ion battery 708455-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

WARNING! To reduce potential safety issues, use only the battery provided with the tablet, a replacement 
battery provided by HP, or a compatible battery purchased from HP.

CAUTION: Removing a battery that is the sole power source for the tablet can cause loss of information. To 
prevent loss of information, save your work or shut down the tablet through Windows before removing the 
battery.

Remove the battery:

1. Position the computer upside down on a flat surface, with the front toward you.

2. Slide the battery release latch (1) to release the battery.
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3. Rotate the battery at an angle (2), and then remove the battery from the computer (3).

Install the battery by inserting it into the battery bay until you hear a click.

SIM card

A SIM card slot is located in the battery bay.

Before removing the SIM card, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the SIM card:

▲ To remove a SIM card, press in on the SIM card, and then remove it from the slot.

Install the SIM card by inserting it into the SIM card slot until you hear a click.
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Service cover

Description Spare part number

Service cover 733635-001

Before removing the service cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the service cover:

1. Position the computer upside down on a flat surface with the front toward you.

2. With the battery bay toward you, slide the service cover release latch to the left (1), and then remove 
the optional screw (2).

3. Slide the service cover release latch to the left again (3), slide the service cover forward (4), and then lift 
to remove the service cover (5).

NOTE: If you do not want to use the optional screw, you can store it inside the service cover.

Reverse this procedure to install the service cover.

Component replacement procedures 43



Hard drives, primary and secondary

NOTE: The hard drive spare part kit does not include the hard drive bracket, cover, or screws. The hard drive 
bracket, cover, and screws are included in the Hard Drive Hardware Kit, spare part number 734280-001.

Description Spare part number

1-TB, 7200-RPM, SATA, 9.5-mm 766644-001

1-TB, 5400-RPM, SATA, 7.0-mm 778192-001

750-GB, 7200-RPM, SATA, 7.0-mm 778191-001

500-GB, 7200-RPM, SATA, 7.0-mm 703267-001

500-GB, 7200-RPM, SED, 7.0-mm 703268-001

500-GB, 5400-RPM, SATA, FIPS, 7.0-mm 730946-001

Before removing the primary hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Position the computer upside down on a flat surface.

5. Remove the battery (see Battery on page 41).

6. Remove the service cover (see Service cover on page 43).

7. Loosen the 3 captive hard drive screws (1) that secure the hard drive to the computer.

8. Release the hard drive latch (2).

9. Grasp the latch and remove the hard drive (3) from the hard drive bay.
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10. If it is necessary to remove the hard drive cover and bracket, follow these steps:

a. Remove the four Phillips M3.0×3.0 screws (1) that secure the hard drive cover and bracket to the 
hard drive.

b. Remove the hard drive and cover from the bracket (2).

c. Remove the hard drive cover from the hard drive (3).

Reverse this procedure to reassemble and install the hard drive.
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Solid-state drive

Description Spare part number

512 GB, SATA-3 795969-001

512 GB, SATA-3, SED, Opal2 815841-001

512 GB, Z Turbo Drive PCIe 815840-001

256 GB, SATA-3 795966-001

256 GB, M2, PCIe-2×2 794731-001

256 GB, SATA-3, Locked 806895-001

256 GB, SATA-3, SED, Opal2 795968-001

256 GB, Opal2, Locked 830147-001

240 GB, SATA-3 795965-001

180 GB, SATA-3 795964-001

128 GB, SATA-3 795963-001

128 GB, Z Turbo Drive PCIe 815839-001

Before removing the solid-state drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

Remove the solid-state drive:

1. Remove the two Phillips PM2.0×3.0 screws (1) that secure the solid-state drive to the computer. (The 
solid-state drive tilts up.)
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2. Slide the solid-state drive away to remove it from the socket (2).

Reverse this procedure to install the solid-state drive.

WLAN module

Description Spare part number

WLAN Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi + Bluetooth 4.0 Combo Adapter 710663-001

WLAN Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 Combo Adapter 717379-001

WLAN Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 Combo Adapter 747833-001

WLAN Intel Dual Band Wireless-N 7260NB 802.11 a/b/g/n 2×2 WiFi adapter 717380-001

CAUTION: The WLAN module and the WWAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for 
use in the computer by the governmental agency that regulates wireless devices in your country or region. If 
you replace the module and then receive a warning message, remove the module to restore device 
functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

Remove the WLAN module:

1. Position the computer with the front toward you.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1/Main” connects to the WLAN module “1/Main” terminal. 
The WLAN antenna cable labeled “2/Aux” connects to the WLAN module “2/Aux” terminal.

3. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the system board. (The 
WLAN module tilts up.)

4. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion of the WLAN module 
into the WLAN module slot.

Reverse this procedure to install the WLAN module.
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WWAN module

Description Spare part number

HP lt4211 LTE/EV-DO/HSPA+ 4G Module 793116-001

HP lt4112 LTE/HSPA+ Mobile Broadband Module 740011-001

HP hs3110 HSPA+ Mobile Broadband Module 748599-001

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for 
use in the computer by the governmental agency that regulates wireless devices in your country or region. If 
you replace the module and then receive a warning message, remove the module to restore device 
functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable connects to the WWAN module “5/Main” terminal. The blue 
WWAN antenna cable connects to the WWAN module “6/Aux” terminal.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the WWAN module to the system board. (The 
WWAN module tilts up.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch to prevent incorrect insertion of the WWAN module 
into the WWAN module slot.

Reverse this procedure to install the WWAN module.
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RTC battery

Description Spare part number

RTC battery (includes cable and double-sided adhesive) 734300-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the base enclosure. (The RTC battery is attached to the base enclosure 
with double-sided adhesive.)

3. Remove the RTC battery.

Reverse this procedure to install the RTC battery.
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Optical drive

NOTE: The Upgrade Bay supports both optical drives and hard drives. If you switch from a hard drive to an 
optical drive in the Upgrade Bay, you will need to remove four additional screws that secure the hard drive 
carrier. 

NOTE: All optical drive spare part kits include bezel, bracket, and screws.

Description Spare part number

Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive 735600-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive 735599-001

DVD±RW SuperMulti Double-Layer Drive 735602-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

Remove the optical drive:

1. Position the computer with the front toward you.

2. Loosen the Phillips captive screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the tab to 
the left to release the optical drive from the computer.
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4. Remove the optical drive (3).

5. If it is necessary to replace the optical drive bracket:

a. Position the optical drive with the rear toward you.

b. Remove the two Phillips M2.0×3.0 screws (1) that secure the optical drive bracket to the optical 
drive.

c. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Upgrade Bay hard drive

NOTE: The Upgrade Bay hard drive must be installed in the Upgrade Bay hard drive carrier before it can be 
installed in the computer. The Upgrade Bay hard drive carrier is available using spare part number 
734298-001.

Before removing the Upgrade Bay hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

Remove the Upgrade Bay hard drive:

1. Position the computer with the front toward you.

2. Remove the four Phillips PM3.0×5.0 screws (1) that secure the Upgrade Bay hard drive carrier to the 
computer.

3. Loosen the captive Phillips screw (2) that secures the Upgrade Bay hard drive carrier to the computer, 
and then insert a flat-bladed screwdriver or similar tool into the Upgrade Bay hard drive tab access (3) 
and press the tab to the left to release the Upgrade Bay hard drive carrier from the computer (4).
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4. Remove the two Phillips PM2.0×5.0 screws (1) that secure the top bracket to the hard drive carrier, and 
then remove the bracket from the carrier (2).

5. Remove the four Phillips PM2.5×3.0 screws (1) that secure the hard drive to the carrier, and then pull 
the hard drive away from the connector (2) to disengage it.

6. Remove the hard drive (3).

Reverse this procedure to reassemble and install the Upgrade Bay hard drive and Upgrade Bay hard drive 
carrier.

Component replacement procedures 55



Expansion memory module

NOTE: The computer has four memory slots. Expansion memory slots are located in a compartment on the 
bottom of the computer. Primary memory slots are located under the keyboard.

When you add or replace memory modules, slot 1 must be populated before slot 2 is populated.

Description Spare part number

8.0-MB memory module (PC3L-12800, 1600 MHz, DDR3L) 693374-001

4.0-MB memory module (PC3L-12800, 1600 MHz, DDR3L) 691740-001

Before removing an expansion memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

Remove an expansion memory module:

1. Spread the retention tabs (1) on each side of the expansion memory module slot to release the 
expansion memory module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the expansion memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch to prevent incorrect installation into the expansion 
memory module slots.

Reverse this procedure to install an expansion memory module.
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Keyboard

NOTE: The keyboard spare part kit includes a backlight and cable, pointing stick and cable, TouchPad and 
cable, and the keyboard cable.

For use in country or region Spare part number For use in country or region Spare part number

Keyboard with backlight, pointing stick and TouchPad (includes 
backlight, keyboard, pointing stick, and TouchPad cables):

For use in the Netherlands 733688-B31

For use in Belgium 733688-A41 For use in Northwest Africa 733688-FP1

For use in Brazil 733688-201 For use in Norway 733688-091

For use in Bulgaria 733688-261 For use in Portugal 733688-131

For use in Canada 733688-DB1 For use in Romania 733688-271

For use in the Czech Republic and Slovakia 733688-FL1 For use in Russia 733688-251

For use in Denmark 733688-081 For use in Saudi Arabia 733688-171

For use in France 733688-051 For use in Slovenia 733688-BA1

For use in Germany 733688-041 For use in South Korea 733688-AD1

For use in Greece 733688-151 For use in Spain 733688-071

For use in Hungary 733688-211 For use in Sweden and Finland 733688-B71

For use in Iceland 733688-DD1 For use in Switzerland 733688-BG1

For use in India 733688-D61 For use in Taiwan 733688-AB1

For use in Israel 733688-BB1 For use in Thailand 733688-281

For use in Italy 733688-061 For use in Turkey 733688-141

For use in Japan 733688-291 For use in the United Kingdom 
and Singapore

733688-031

For use in Latin America 733688-161 For use in the United States 733688-001

Keyboard with pointing stick and TouchPad (includes keyboard, pointing stick, and TouchPad cables):

For use in Belgium 745663-A41 For use in Northwest Africa 745663-FP1

For use in Brazil 745663-201 For use in Norway 745663-091

For use in Bulgaria 745663-261 For use in Portugal 745663-131

For use in Canada 745663-DB1 For use in Romania 745663-271

For use in the Czech Republic and Slovakia 745663-FL1 For use in Russia 745663-251

For use in Denmark 745663-081 For use in Saudi Arabia 745663-171

For use in France 745663-051 For use in Slovenia 745663-BA1

For use in Germany 745663-041 For use in South Korea 745663-AD1

For use in Greece 745663-151 For use in Spain 745663-071

For use in Hungary 745663-211 For use in Sweden and Finland 745663-B71

For use in Iceland 745663-DD1 For use in Switzerland 745663-BG1

For use in India 745663-D61 For use in Taiwan 745663-AB1
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For use in country or region Spare part number For use in country or region Spare part number

For use in Israel 745663-BB1 For use in Thailand 745663-281

For use in Italy 745663-061 For use in Turkey 745663-141

For use in Japan 745663-291 For use in Turkey, F-type keyboard 745663-541

For use in Latin America 745663-161 For use in the United Kingdom 
and Singapore

745663-031

For use in the Netherlands 745663-B31 For use in the United States 745663-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or Upgrade Bay hard drive (see Upgrade Bay 
hard drive on page 54).

Remove the keyboard:

1. Turn the computer upside down the front toward you.

2. Loosen the two Phillips captive screws that secure the keyboard to the computer.

3. Position the computer on its side with the display open at a 90-degree angle.
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4. Insert a screw driver or similar thin tool into the keyboard release opening in the optical drive bay, and 
then press on the back of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right side up with the front toward you.

6. Open the computer as far as it will open.

7. Lift the rear edge of the keyboard, and then swing it up and forward until it rests upside down on the 
palm rest.

8. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and then 
disconnect the keyboard cable from the system board.

9. Release the ZIF connector (2) to which the pointing stick cable is attached, and then disconnect the 
pointing stick cable (2) from the system board.
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10. Remove the keyboard (3).

Reverse this procedure to install the keyboard.

Primary memory module

NOTE: The computer has four memory slots. Expansion memory slots are located in a compartment on the 
bottom of the computer. Primary memory slots are located under the keyboard.

When you add or replace the primary memory modules, populate the bottom slot before the top slot.

Description Spare part number

8.0-MB memory module (PC3L-12800, 1600 MHz, DDR3L) 693374-001

4.0-MB memory module (PC3L-12800, 1600 MHz, DDR3L) 691740-001

Before removing a primary memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43)
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6. Remove the optical drive (see Optical drive on page 52) or Upgrade Bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

Remove the primary memory module:

1. Spread the retetntion tabs (1) on each side of the primary memory module slot to release the primary 
memory module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the primary memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch to prevent incorrect installation into the primary 
memory module slots.

Reverse this procedure to install a primary memory module.
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6 Removal and replacement procedures for 
Authorized Service Provider parts

CAUTION: Components described in this chapter should only be accessed by an authorized service provider. 
Accessing these parts can damage the computer or void the warranty.

Component replacement procedures
This chapter provides removal and replacement procedures for Authorized Service Provider only parts.

There are as many as 91 screws that must be removed, replaced, or loosened when servicing Authorized 
Service Provider only parts. Make special note of each screw size and location during removal and 
replacement.

Display bezel

NOTE: The display bezel, webcam/microphone module, microphone module, and display panel can be 
removed without removing the display assembly from the computer.

Description Spare part number

For use only on computer models equipped with a webcam 733633-001

For use only on computer models not equipped a webcam 735589-001

Before removing the display bezel, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the display bezel:

1. Turn the computer right side up with the front toward you.

2. Open the computer as far as it will open.
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3. Remove the screw covers (1) and the two Phillips PM2.0x7.0 screws (2) that secure the display bezel to 
the display enclosure.

The screw covers are available in the Display Panel Support Kit, spare part number 784211-001.

4. Flex the inside edges of the bottom edge (1), the left and right sides (2), and the top edge (3) of the 
display bezel until the bezel disengages from the display enclosure and then remove the bezel (4).

NOTE: The top edge of the display bezel contains double-sided adhesive. Additional pressure may be 
needed to detach the top edge of the display bezel from the display enclosure.

Reverse this procedure to install the display bezel.
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Display panel

Description Spare part number

17.3-in, FHD, AG, LED, WVA display panel 735367-001

17.3-in, HD, AG, LED, WVA display panel 735366-001

Before removing the display panel, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the display bezel (see Display bezel on page 62).

Remove the display panel:

1. Release the top edge of the display panel from the display enclosure (1).

NOTE: If grounding tape secures the top edge of the display panel to the display enclosure, release 
the tape to disengage the panel from the enclosure.

2. Remove the six Torx T8M2.5×7.0 screws (2) that secure the display panel to the display enclosure.
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3. Lift the tape that covers the connector on the back of display panel (1), and then disconnect the display 
panel cable (2).

4. Remove the eight Phillips PM2.0×3.0 screws (1) that secure the display panel to the display hinge 
brackets.

5. Slide the display panel up and out of the display hinge brackets (2).

To replace the remaining display assembly components, remove the display assembly from the computer.

Reverse this procedure to install the display panel. For more information, see Display assembly on page 77.
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Webcam/microphone module

Description Spare part number

Webcam/microphone module (includes double-sided adhesive) 784208-001

Microphone module (includes double-sided adhesive) 735370-001

Before removing the webcam/microphone module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the display bezel (see Display bezel on page 62).

6. Remove the display panel (see Display panel on page 64).

Remove the webcam/microphone module:

1. Disconnect the cable from the webcam/microphone module (1).

2. Detach the webcam/microphone module (2) from the display enclosure. (The webcam/microphone 
module is attached to the display enclosure with double-sided tape.)

Reverse this procedure to install the webcam/microphone module.
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Top cover

Description Spare part number

Top cover 735587-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

NOTE: When replacing the top cover, be sure that the following components are removed from the 
defective top cover and installed on the replacement top cover:

● Multifunction board (see Multifunction board on page 71)

● Speakers (see Speakers on page 73)

● Fingerprint reader (see Fingerprint reader on page 74)

● Power button board (see Power button board on page 75)

Remove the top cover:

1. Close the computer.

2. Turn the computer upside with the front toward you.
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3. Remove the two Torx T8M2.5x11.0 screws (1) and the nine Torx T8M2.5x6.0 screws (2) that secure the 
base enclosure to the top cover.

4. Remove the four Torx T8M2.5x5.0 screws inside the battery bay (1) and the three Torx T8M2.5x5.0 
screws in the optical drive/upgrade drive bay (2).

5. Turn the computer right side up with the front toward you.

6. Open the computer as far as it will open.
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7. Disconnect the following cables:

(1) Function board ZIF connector cable

(2) Power button board ZIF connector cable

(3) TouchPad ZIF connector cable

(4) Fingerprint reader board ZIF connector cable

8. Starting at the top right, release the top cover from the base enclosure (1).
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9. Remove the top cover from the base enclosure (2).

Reverse this procedure to install the top cover.
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Multifunction board

Description Spare part number

Multifunction board (includes LED light pipe) 733639-001

Before removing the multifunction board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

Remove the multifunction board:

1. Turn the top cover right side up with the front toward you.

2. Detach the multifunction board cable (2) from the top cover. (The multifunction board cable is attached 
to the top cover with double-sided tape.)
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3. Turn the top cover upside down with the front toward you.

4. Remove the Phillips PM2.0×3.0 screw (1) that secures the multifunction board to the top cover.

5. Slide the multifunction board cable through the opening in top cover (2).

6. Remove the multifunction board and cable (3).

Reverse this procedure to install the multifunction board.

72 Chapter 6   Removal and replacement procedures for Authorized Service Provider parts



Speakers

Description Spare part number

Speakers 733638-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

Remove the speakers:

1. Disconnect the speaker cable from the system board (1).

2. Remove the two Torx T8M2.5×4.0 screws (2) that secure the speakers to the base enclosure.

3. Remove the speakers (3).
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Reverse this procedure to install the speakers.

Fingerprint reader

Description Spare part number

Fingerprint reader (includes cable) 737730-001

Before removing the fingerprint reader, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41)

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

Remove the fingerprint reader:

1. Turn the top cover upside down with the front toward you.

2. Remove the Phillips PM2.0×3.0 screw (1) that secures the fingerprint reader to the top cover.

3. Remove the fingerprint reader bracket (2).

The fingerprint reader bracket is available in the Bracket Kit using spare part number 733637-001.

4. Detach the fingerprint reader cable (3) from the top cover. (The fingerprint reader cable is attached to 
the top cover with double-sided tape.)

74 Chapter 6   Removal and replacement procedures for Authorized Service Provider parts



5. Remove the fingerprint reader (4).

Reverse this procedure to install the fingerprint reader.

Power button board

Description Spare part number

Power button board (includes cable) 733636-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41)

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

Remove the power button board:

1. Turn the top cover upside down with the front toward you.

2. Release the power button board cable through the opening in top cover (1).
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3. Detach the power button board cable (2) from the top cover. (The power button board cable is attached 
to the top cover with double-sided tape.)

4. Remove the Phillips PM2.0×3.0 screw (3) that secures the power button board to the top cover.

5. Lift the bottom edge of the power button board, and then remove the power button board by sliding it 
up and away at an angle from the tab that secures it in place (4).

Reverse this procedure to install the power button board.
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Display assembly

The display bezel, webcam/microphone module, microphone module, and display panel can be removed 
without removing the entire display assembly. See Display bezel on page 62, Webcam/microphone module 
on page 66, and Display panel on page 64 for more information.

Description Spare part number

17.3-in, AG, FHD, LED, UWVA display assembly for use on computer models equipped with a webcam 784207-001

17.3-in, AG, FHD, LED, UWVA display assembly for use on computer models not equipped with a webcam 784206-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

Remove the display assembly:

1. Turn the computer upside down with the front toward you.
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2. Release the WLAN and WWAN antenna cables from the routing channel built into the base enclosure.

3. Turn the computer right side up with the front toward you.

4. Open the computer as far as it will open.

5. Release the WLAN and WWAN antenna cables through the opening in the base enclosure.

6. Close the computer.

7. Position the computer with the rear toward you.

8. Remove the four Torx T8M2.5×3.0 screws (1) that secure the hinge cover to the computer.
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9. Remove the hinge cover (2).

The hinge cover is available using spare part number 733634-001.

10. Remove the two Torx T8M2.5×7.0 screws that secure the display assembly to the computer.

11. Position the computer with the front toward you.

12. Open the computer as far as it will open.

CAUTION: Support the display assembly when removing the display assembly screws in the following 
steps. Failure to support the display assembly can result in damage to the display assembly and other 
components.

13. Remove the two Torx T8M2.0×5.0 screws (1) that secure the display panel cable to the system board.

14. Remove the display panel cable bracket (2).

15. Detach the display panel cable (3) from the base enclosure. (The display panel cable is attached to the 
base enclosure with double-sided tape.)
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16. Disconnect the display panel cable from the system board (4).

17. Remove the two Torx T8M2.5×7.0 screws (1) that secure the display assembly to the computer.

18. Remove the display assembly (2).

19. If it is necessary to replace the display hinges:

● Remove the display bezel (see Display bezel on page 62)

● Remove the display panel (see Display panel on page 64)
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a. Remove the eight Phillips PM2.0×3.0 screws (1) that secure the hinge assemblies to the 
display panel.

b. Remove the hinge assemblies (2).

The hinge assemblies are available in the Display Hinge Kit using spare part number 733634-001.

20. If it is necessary to replace the display panel cable:

a. Detach the display panel cable (2) from the display enclosure. (The display panel cable is attached 
to the display enclosure with double-sided tape.)

b. Remove the display panel cable (2).

The display panel cable is available in the Cable Kit, 785212-001.

Reverse this procedure to install the display assembly.
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ExpressCard assembly

Description Spare part number

ExpressCard assembly 794578-001

Before removing the ExpressCard assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

Remove the ExpressCard assembly:

1. Remove the Torx T8M2.5×4.0 screw (1) that secures the light pipe to the computer.

2. Remove the light pipe (2).

3. Remove the four Torx T8M2.5×4.0 screws (3) that secure the ExpressCard assembly to the system 
board.

4. Lift up on the right side (4) of the ExpressCard assembly to disconnect it from the 
system board connector.
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5. Remove the ExpressCard assembly (5) by sliding it up and to the right at an angle.

Reverse this procedure to install the ExpressCard assembly.

Smart Card reader

Description Spare part number

Smart Card reader (includes cable) 742159-001

Before removing the Smart Card reader, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

9. Remove the ExpressCard assembly (see ExpressCard assembly on page 82).

Remove the Smart Card:

1. Remove the three Phillips PM2.5×4.0 screws (1) that secure the Smart Card reader to the system board.

2. Lift the Smart Card reader slightly upward and toward the left (2).
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3. Release the ZIF connector (3) to which the Smart Card reader cable is attached, and then disconnect the 
Smart Card reader cable from the system board.

4. Remove the Smart Card reader (4).

Reverse this procedure to install the Smart Card reader.

Audio/USB board

Description Spare part number

Audio/USB board (includes audio jack and USB port) 737732-001

Before removing the audio/USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41),

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

Remove the audio/USB board:
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1. Remove the four Phillips M2.5×4.0 screws (1) that secure the audio/USB board to the base enclosure.

2. Lift up on the left side of the board to disconnect it from the system board connector (2).

3. Remove the audio/USB board (3) by sliding it up and to the left at an angle.

Reverse this procedure to install the audio/USB board.

Component replacement procedures 85



Processor heat sink

Description Spare part number

For use only with computer models equipped with quad-core processors 735372-001

For use only with computer models equipped with dual-core processors 735371-001

Before removing the processor heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41)

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

Remove the processor heat sink:

1. Following the sequence stamped into the processor heat sink, loosen the four Phillips captive screws 
(1) that secure the processor heat sink to the system board.

NOTE: If there is Mylar tape that secures the heat sink to the fan, release the tape to disengage the 
heat sink.
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2. Remove the heat sink (2).

NOTE: Use the image below that best matches your model.

NOTE: Thermal paste located on the surfaces of the processor (1) and the processor heat sink (2). 
Replacement thermal paste and pads are included in the processor heat sink and processor spare part kits.
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Reverse this procedure to install the processor heat sink.
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Processor

NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Intel Core i7-4940MX 3.10-GHz (SC turbo up to 4.00-GHz) processor (1600-MHz FSB, 8.0-MB L3 cache, 
quad core, 8 threads, 57-W)

778694-001

Intel Core i7-4910MQ 2.90-GHz (SC turbo up to 3.90-GHz) processor (1600-MHz FSB, 8.0-MB L3 cache, 
quad core, 8 threads, 47-W)

778693-001

Intel Core i7-4810MQ 2.80-GHz (SC turbo up to 3.80-GHz) processor (1600-MHz FSB, 6.0-MB L3 cache, 
quad core, 8 threads, 47-W)

778692-001

Intel Core i7-4710MQ 2.50-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz FSB, 6.0-MB L3 cache, 
quad core, 8 threads, 47-W)

773212-001

Intel Core i7-4610M 3.00-GHz (SC turbo up to 3.70-GHz) processor (1600-MHz FSB, 4.0-MB L3 cache, dual 
core, 4 threads, 37-W)

765141-001

Intel Core i5-4340M 2.90-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz FSB, 3.0-MB L3 cache, dual 
core, 4 threads, 37-W)

765142-001

Intel Core i5-4210M 2.60-GHz (SC turbo up to 3.20-GHz) processor (1600-MHz FSB, 3.0-MB L3 cache, dual 
core, 4 threads, 37-W)

768420-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41)

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

9. Remove the processor heat sink (see Processor heat sink on page 86).

Remove the processor:

1. Use a Torx T8 screwdriver to turn the processor locking screw (1) one-half turn counterclockwise, until 
you hear a click.
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2. Lift the processor (2) straight up and remove it.

NOTE: When installing the processor, the gold triangle (3) on the processor must be aligned with the 
triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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Graphics subsystem heat sink

NOTE: The graphics subsystem heat sink includes a fan and replacement thermal material.

Description Spare part number

For use only on computer models equipped with the NVIDIA Quadro K5100M graphics board 735373-001

For use only on computer models equipped with the NVIDIA Quadro K4100M or K3100M graphics board 735374-001

For use only on computer models equipped with the MXM-Emerald graphics board 786687-001

For use only on computer models equipped with the MXM-N15P-15 graphics board 786686-001

For use only on computer models equipped with the MXM-N15P-Q1 graphics board (includes fan) 768730-001

NOTE: To properly ventilate the computer, allow at least a 7.6‑cm (3‑inch) clearance on the left side of the 
computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor 
and is designed to turn on automatically when high temperature conditions exist. These conditions are 
affected by high external temperatures, system power consumption, power management/battery 
conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced 
through the ventilation grill located on the left side of the computer.

Before removing the graphics subsystem heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see service cover).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67)

Remove the graphics subsystem heat sink:

1. If present, release the tape that promotes airflow between the fan and the processor heat sink.

2. Disconnect the fan cable from the system board (1).

3. Following the sequence stamped into the graphics subsystem heat sink, loosen the four captive Torx 
screws (2) that secure the graphics subsystem heat sink to the system board.
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4. Remove the graphics subsystem heat sink (3).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the graphics subsystem heat 
sink and the graphics board each time the graphics subsystem heat sink is removed. Thermal material is used 
on the system board component closest to the fan (1) and the heat sink component that services it (2), as 
well as on the graphics board (3) and various locations on the graphics subsystem heat sink section (4) that 
services it.

Use the image below that matches the computer’s thermal pad configuration.
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Reverse this procedure to install the graphics subsystem heat sink.

Graphics board

NOTE: The graphics board spare part kit includes replacement thermal material.

Description Spare part number

AMD FirePro W6170M 786689-001

NVIDIA K1100M N15P-Q1 785214-001

NVIDIA Quadro K5100M 781701-001

NVIDIA Quadro K4100M 781702-001

NVIDIA Quadro K3100M 781703-001

NVIDIA Quadro K2200M 786688-001

Before removing the graphics board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

9. Remove the graphics board fan/heat sink assembly (see Graphics subsystem heat sink on page 91).

Remove the graphics board:

1. Remove the two Torx T8M2.5×4.0 screws (1) that secure the graphics board to the system board.

2. Lift the right edge of the graphics board until it rests at an angle (2), and then remove it from the 
connector (3).

Reverse this procedure to install the graphics board.
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Power connector cable

NOTE: The power connector cable is included in the Cable Kit, spare part number 785212-001.

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

9. Remove the display assembly (see Display assembly on page 77).

10. Remove the graphics subsystem heat sink (see Graphics subsystem heat sink on page 91).

Remove the power connector cable:

1. Remove the Torx T8M2.5×7.0 screw (1) that secures to the rear corner cover/left to the base enclosure.

2. Remove the rear corner cover/left (2).

The rear corner cover/left is available in the Plastics Kit, 733637-001.

3. Remove the Torx T8M2.5×4.0 screw (3) that secures to the power connector bracket.

4. Remove the power connector bracket (4).

The power connector bracket is available in the Bracket Kit, spare part number 737734-001.

5. Disconnect the power connector cable from the system board (5).
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6. Remove the power connector cable (6).

Reverse this procedure to install the power connector cable.

System board

NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number

For use only on computer models equipped with a quad core processor and the Windows 10 or Windows 8 
Professional operating system

784213-601

For use only on computer models equipped with a quad core processor and the Windows 10 or Windows 8 
Standard operating system

784213-501

For use only on computer models equipped with a quad core processor and a non-Windows 8 operating 
system

784213-001

For use only on computer models equipped with a dual core processor and the Windows 10 or Windows 8 
Professional operating system

784212-601

For use only on computer models equipped with a dual core processor and the Windows 10 or Windows 8 
Standard operating system

784212-501

For use only on computer models equipped with a dual core processor and a non-Windows 8 operating 
system

784212-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service cover (see Service cover on page 43).

6. Remove the optical drive (see Optical drive on page 52) or upgrade bay hard drive (see Upgrade Bay 
hard drive on page 54).

7. Remove the keyboard (see Keyboard on page 57).

8. Remove the top cover (see Top cover on page 67).

9. Remove the display assembly (see Display assembly on page 77).

10. Remove the graphics board fan/heat sink (see Graphics subsystem heat sink on page 91).

11. Remove the processor heat sink (see Processor heat sink on page 86).

12. Remove the audio/USB board (see Audio/USB board on page 84).

13. Remove the Smart Card reader (see Smart Card reader on page 83).

14. Remove the Expresscard assembly (see ExpressCard assembly on page 82).

When replacing the system board, be sure that the following additional components are removed from the 
defective system board and installed on the replacement system board:

● SIM (see SIM card on page 42)

● WLAN module (see WLAN module on page 47)

● WWAN module (see WWAN module on page 49)

● Solid-state drive (see Solid-state drive on page 46)

● Hard drives (see Hard drives, primary and secondary on page 44)

● Primary memory modules (see Primary memory module on page 60)

● Expansion memory modules (see Expansion memory module on page 56)

● Graphics board (see Graphics board on page 94)

● Processor (see Processor on page 89)

Remove the system board:

1. Remove the rear corner cover/right (1).

The rear corner cover/right is available in the Plastics Kit, 733637-001.

2. Remove the Torx T8M2.5×4.0 screw that secures the RJ-45 connector bracket (2).
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3. Remove the RJ-45 connector bracket (3).

The RJ-45 connector bracket is available in the Bracket Kit, spare part number 737734-001.

4. Disconnect the power connector cable (1) and the speaker cable (2) from the system board.

5. Remove the six Torx T8M2.5×4.0 screws (3) that secure the system board to the base enclosure.
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6. Lift up on the left side of the system board (4) until it rests at an angle, and then remove it by sliding it 
up and to the left at an angle.

When replacing the system board, note the location of the thermal material on the system board (1) and the 
base enclosure (2).

Reverse this procedure to install the system board.
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7 Computer Setup (BIOS), TPM, and 
HP Sure Start – Windows 10

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and 
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup 
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of 
system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from 
operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if 
USB legacy support is enabled.

To start Computer Setup, follow these steps:

▲ Start Computer Setup.

● Computers or tablets with keyboards:

▲ Turn on or restart the computer, and when the HP logo appears, press f10 to enter 
Computer Setup.

● Tablets without keyboards:

▲ Turn off the tablet. Press the power button in combination with the volume down button until 
the Startup menu is displayed, and then tap F10 to enter Computer Setup.
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Navigating and selecting in Computer Setup

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or 
use a pointing device to select the item.

NOTE: On tablets without keyboards, you can use your finger to make selections.

● To scroll up and down, select the up arrow or the down arrow in the upper-right corner of the screen, or 
use the up arrow key or the down arrow key on the keyboard.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow 
the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Select the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.

‒ or –

Select Main, select Ignore Changes and Exit, and then press enter.

● To save your changes and exit Computer Setup menus:

Select the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.

‒ or –

Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Start Computer Setup. See Starting Computer Setup on page 101.

2. Select Main, and then select Apply Factory Defaults and Exit.

NOTE: On select products, the selections may display Restore Defaults instead of Apply Factory 
Defaults and Exit.

3. Follow the on-screen instructions.

4. To save your changes and exit, select the Save icon in the lower-right corner of the screen, and then 
follow the on-screen instructions.

‒ or –

Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory settings. 
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.

Determining the BIOS

To decide whether you need to update Computer Setup (BIOS), first determine the BIOS version on 
your computer.

BIOS version information (also known as ROM date and System BIOS) can be accessed by pressing fn+esc (if 
you are already in Windows) or by using Computer Setup.

1. Start Computer Setup. See Starting Computer Setup on page 101.

2. Select Main, and then select System Information.

3. To exit Computer Setup without saving your changes, select the Exit icon in the lower-right corner of 
the screen, and then follow the on-screen instructions.

‒ or –

Select Main, select Ignore Changes and Exit, and then press enter.

To check for later BIOS versions, see Downloading a BIOS update on page 103.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and 
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. 
Do not download or install a BIOS update while the computer is running on battery power, docked in an 
optional docking device, or connected to an optional power source. During the download and installation, 
follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Type support in the taskbar search box, and then select the HP Support Assistant app.

‒ or –

Select the question mark icon in the taskbar.

2. Select Updates, and then select Check for updates and messages.

3. Follow the on-screen instructions.

4. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on 
your computer. Make a note of the date, name, or other identifier. You may need this information 
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is downloaded. 
You will need to access this path when you are ready to install the update.
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NOTE: If you connect your computer to a network, consult the network administrator before 
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download 
is complete. If no instructions are revealed, follow these steps:

1. Type file in the taskbar search box, and then select File Explorer.

2. Select your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder that contains the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.

Changing the boot order using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Access the Boot Device Options menu:

● Computers or tablets with keyboards:

▲ Turn on or restart the computer, and when the HP logo appears, press f9 to enter the Boot 
Device Options menu.

● Tablets without keyboards:

▲ Turn off the tablet. Press the power button in combination with the volume down button until 
the Startup menu is displayed, and then tap F9 to enter the Boot Device Options menu.

2. Select a boot device, then press enter.
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TPM BIOS settings (select products only)
IMPORTANT: Before enabling Trusted Platform Module (TPM) functionality on this system, you must 
ensure that your intended use of TPM complies with relevant local laws, regulations and policies, and 
approvals or licenses must be obtained if applicable. For any compliance issues arising from your operation/
usage of TPM which violates the above mentioned requirement, you shall bear all the liabilities wholly and 
solely. HP will not be responsible for any related liabilities.

TPM provides additional security for your computer. You can modify the TPM settings in Computer Setup 
(BIOS).

NOTE: If you change the TPM setting to Hidden, TPM is not visible in the operating system. 

To access TPM settings in Computer Setup:

1. Start Computer Setup. See Starting Computer Setup on page 101.

2. Select Security, select TPM Embedded Security, and then follow the on-screen instructions.

Using HP Sure Start (select products only)
Select computer models are configured with HP Sure Start, a technology that continuously monitors 
the computer's BIOS for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start 
automatically restores the BIOS to its previously safe state, without user intervention.

HP Sure Start is configured and already enabled so that most users can use the HP Sure Start default 
configuration. The default configuration can be customized by advanced users.

To access the latest documentation on HP Sure Start, go to http://www.hp.com/support, and select 
your country. Select Drivers & Downloads, and then follow the on-screen instructions.
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8 HP PC Hardware Diagnostics (UEFI) – 
Windows 10

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run 
diagnostic tests to determine whether the computer hardware is functioning properly. The tool runs outside 
the operating system so that it can isolate hardware failures from issues that are caused by the operating 
system or other software components.

NOTE: To start BIOS on a convertible computer, your computer must be in notebook mode and you must 
use the keyboard attached to your tablet. The on-screen keyboard, which displays in tablet mode, cannot 
access BIOS.

To start HP PC Hardware Diagnostics UEFI:

1. Start BIOS:

● Computers or tablets with keyboards:

▲ Turn on or restart the computer, quickly press esc.

● Tablets without keyboards:

▲ Turn on or restart the tablet, and then quickly hold down the volume down button.

‒ or –

Turn on or restart the tablet, and then quickly hold down the Windows button.

2. Press or tap f2.

The BIOS searches three places for the diagnostic tools, in the following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading 
HP PC Hardware Diagnostics (UEFI) to a USB device on page 107.

b. Hard drive

c. BIOS

3. When the diagnostic tool opens, select the type of diagnostic test you want to run, and then follow 
the on-screen instructions. On a tablet, press the volume down button to stop a diagnostic test.

NOTE: If you need to stop a diagnostic test on computers or tablets with a keyboard, press esc.
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Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
There are two options to download HP PC Hardware Diagnostics to a USB device:

Download the latest UEFI version:

1. Go to http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. In the HP PC Hardware Diagnostics section, click the Download link, and then select Run.

Download any version of UEFI for a specific product:

1. Go to http://www.hp.com/support, and then select your country. The HP Support page is displayed.

2. Click Drivers & Downloads.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer, and then select your operating system.

5. In the Diagnostic section, follow the on-screen instructions to select and download the UEFI version 
you want.
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9 Computer Setup (BIOS), MultiBoot, and 
System Diagnostics – Windows 8

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and 
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup 
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of 
system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from 
operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if 
USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard 
to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press 
enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the 
screen, or use the up arrow key or the down arrow key on the keyboard.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and then 
follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –
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Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring default settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and then 
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the default settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on 
the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn+esc (if 
you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and 
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. 
Do not download or install a BIOS update while the computer is running on battery power, docked in an 
optional docking device, or connected to an optional power source. During the download and installation, 
follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, select the HP Support Assistant app.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on 
your computer. Make a note of the date, name, or other identifier. You may need this information 
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your hard 
drive where the BIOS update is downloaded. You will need to access this path when you are ready 
to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing 
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the 
download is complete. If no instructions are displayed, follow these steps:
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1. From the Start screen, type e, and then click File Explorer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the 
update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.

Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is 
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include 
optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices 
contain bootable media or files that the computer needs to start and operate properly.

NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the boot 
order.

You can change the order in which the computer searches for a boot device by changing the boot order in 
Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed 
at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot 
devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to 
prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

● To set a new boot order that the computer uses each time it is turned on, by changing the boot order in 
Computer Setup.

● To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options 
menu.

● To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each 
time the computer is turned on or restarted.
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Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or 
restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then press enter.

4. To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.

– or –

To move the device down in the boot order, use a pointing device to click the down arrow, or press the - 
key.

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc while 
the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press f9.

3. Use a pointing device or the arrow keys to select a boot device, then press enter.
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Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the 
computer is started or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select System Configuration > Boot Options, and then press 
enter.

4. In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the 
computer to display the startup location menu before it defaults to the current MultiBoot setting. 
(When 0 is selected, the Express Boot startup location menu is not displayed.)

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

● To specify a boot device from the Express Boot menu, select your preference within the allotted time, 
and then press enter.

● To prevent the computer from defaulting to the current MultiBoot setting, press any key before the 
allotted time expires. The computer will not start until you select a boot device and press enter.

● To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to 
expire.
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Using System Diagnostics
System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is functioning 
properly. The following diagnostic tests may be available in System Diagnostics:

● System Tune-Up—This group of additional tests checks your computer to make sure that the main 
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests on 
memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery 
calibration), video memory, and the WLAN module status.

● Start-up test—This test analyzes the main computer components that are required to start the 
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up 
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all data in 
every sector of the hard drive. If the test detects a damaged sector, it attempts to move the data to a 
good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an error, 
replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary. If 
the battery fails the test, contact HP support to report the issue and purchase a replacement battery.

● BIOS Management—You can update or rollback the version of the BIOS on the system. Do not shut 
down or remove external power during the process. You will be given a confirmation screen before your 
BIOS is modified. Select BIOS update, BIOS Rollback, or Back to main menu.

You can view system information and error logs or select languages in the System Diagnostics window.

To start System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is displayed in 
the lower-left corner of the screen, press esc. When the Startup Menu is displayed, press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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10 Computer Setup (BIOS), MultiBoot, and UEFI 
– Windows 7

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and 
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup 
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of 
system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from 
operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if 
USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard 
to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press 
enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the 
screen, or use the up arrow key or the down arrow key on the keyboard.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and then 
follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –
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Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring default settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and then 
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the default settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on 
the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn+esc (if 
you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and 
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. 
Do not download or install a BIOS update while the computer is running on battery power, docked in an 
optional docking device, or connected to an optional power source. During the download and installation, 
follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Access Help and Support by selecting Start > Help and Support.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on 
your computer. Make a note of the date, name, or other identifier. You may need this information 
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your hard 
drive where the BIOS update is downloaded. You will need to access this path when you are ready 
to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing 
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the 
download is complete. If no instructions are displayed, follow these steps:

1. Select Start > Computer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the 
update.
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4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.

Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is 
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include 
optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices 
contain bootable media or files that the computer needs to start and operate properly.

NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the boot 
order.

You can change the order in which the computer searches for a boot device by changing the boot order in 
Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed 
at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot 
devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to 
prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

● To set a new boot order that the computer uses each time it is turned on, by changing the boot order in 
Computer Setup.

● To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options 
menu.

● To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each 
time the computer is turned on or restarted.

118 Chapter 10   Computer Setup (BIOS), MultiBoot, and UEFI – Windows 7



Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or 
restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then press enter.

4. To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.

– or –

To move the device down in the boot order, use a pointing device to click the down arrow, or press the - 
key.

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc while 
the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press f9.

3. Use a pointing device or the arrow keys to select a boot device, then press enter.

Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the 
computer is started or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select System Configuration > Boot Options, and then press 
enter.

4. In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the 
computer to display the startup location menu before it defaults to the current MultiBoot setting. 
(When 0 is selected, the Express Boot startup location menu is not displayed.)

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
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Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

● To specify a boot device from the Express Boot menu, select your preference within the allotted time, 
and then press enter.

● To prevent the computer from defaulting to the current MultiBoot setting, press any key before the 
allotted time expires. The computer will not start until you select a boot device and press enter.

● To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to 
expire.

Using HP PC Hardware Diagnostics (UEFI) (select models only)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run 
diagnostic tests to determine if the computer hardware is functioning properly. The tool runs outside of the 
operating system to isolate hardware failures from issues that may be caused by the operating system or 
other software components.

To start HP PC Hardware Diagnostics UEFI:

1. Turn on or restart the computer, quickly press esc, and then press f2.

After pressing f2, the BIOS searches three places for the HP PC Hardware Diagnostics (UEFI) tools in the 
following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading 
HP PC Hardware Diagnostics (UEFI) to a USB device on page 120.

b. Hard drive

c. BIOS

2. Click the type of diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test while it is running, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only.

1. Go to http://www.hp.com.

2. Click Support & Drivers, and then click the Drivers & Software tab.

3. Enter the product name in the text box, and then click Search.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

– or –

Click Download, and then select Run.
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11 Computer Setup (BIOS) and Advanced 
System Diagnostics – SUSE Linux

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and 
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup 
includes settings for the types of peripherals installed, the startup sequence of the computer, and the 
amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from 
operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if 
USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press 
enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the 
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and then 
follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard 
to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner 
of the screen, and then follow the on-screen instructions.

– or –
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Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring default settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow 
the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the default settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on 
the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing the esc 
key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and 
then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and 
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. 
Do not download or install a BIOS update while the computer is running on battery power, docked in an 
optional docking device, or connected to an optional power source. During the download and installation, 
follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For worldwide 
support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want to 
download.

3. Click the option for software and driver downloads, type your computer model number in the product 
box, and then press enter. Follow the on-screen instructions to identify your computer and access the 
BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.
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Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is 
functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start the 
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up 
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all data in 
every sector of the hard drive. If the test detects a damaged sector, it attempts to move the data to a 
good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an error, 
replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary. If 
the battery fails the test, contact support to report the issue and purchase a replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the main 
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests on 
memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery 
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is displayed in 
the lower-left corner of the screen, press esc. When the Startup Menu is displayed, press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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12 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 41.60 cm 16.37 in

Depth 27.20 cm 10.70 in

Height (front to back) 3.40 cm to 4.00 cm 1.33 in to 1.57 in

Weight 3.48 kg 7.67 lbs

Input power

Operating voltage and current 19.5 V dc @ 10.25 A — 200 W

19.5 V dc @ 11.79 A — 230 W

NOTE: This product is designed for IT power systems in Norway with phase-to-phase voltage not exceeding 240 V rms.

NOTE: The computer operating voltage and current can be found on the system regulatory label.

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90% 10% to 90%

Nonoperating 5% to 95% 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this range 
of temperatures.
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13 Backup and recovery – Windows 10

This chapter provides information about the following processes. The information in the chapter is standard 
procedure for most products.

● Creating recovery media and backups

● Restoring and recovering your system

For additional information, refer to the HP support assistant app.

▲ Type support in the taskbar search box, and then select the HP Support Assistant app.

‒ or –

Click the question mark icon in the taskbar.

IMPORTANT: If you will be performing recovery procedures on a tablet, the tablet battery must be at least 
70% charged before you start the recovery process.

IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before 
beginning any recovery process.

Creating recovery media and backups
The following methods of creating recovery media and backups are available on select products only. Choose 
the available method according to your computer model.

● Use HP Recovery Manager to create HP Recovery media after you successfully set up the computer. This 
step creates a backup of the HP Recovery partition on the computer. The backup can be used to reinstall 
the original operating system in cases where the hard drive is corrupted or has been replaced. For 
information on creating recovery media, see Creating HP Recovery media (select products only) 
on page 127. For information on the recovery options that are available using the recovery media, see 
Using Windows Tools on page 128.

● Use Windows tools to create system restore points and create backups of personal information.

For more information, see Recovering using HP Recovery Manager on page 129.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.
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Creating HP Recovery media (select products only)

If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu, 
select File Explorer, and then select This PC.

● If your computer does not list the Windows partition and the Recovery partition, you can obtain 
recovery media for your system from support. See the Worldwide Telephone Numbers booklet included 
with the computer. You can also find contact information on the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

You can use Windows tools to create system restore points and create backups of personal information, 
see Using Windows tools on page 61.

● If your computer does list the Recovery partition and the Windows partition, you can use HP Recovery 
Manager to create recovery media after you successfully set up the computer. HP Recovery media can 
be used to perform system recovery if the hard drive becomes corrupted. System recovery reinstalls 
the original operating system and software programs that were installed at the factory and then 
configures the settings for the programs. HP Recovery media can also be used to customize the system 
or restore the factory image if you replace the hard drive.

◦ Only one set of recovery media can be created. Handle these recovery tools carefully, and keep 
them in a safe place.

◦ HP Recovery Manager examines the computer and determines the required storage capacity for 
the media that will be required.

◦ To create recovery discs, your computer must have an optical drive with DVD writer capability, and 
you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use 
rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray) 
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a 
high-quality blank USB flash drive.

◦ If your computer does not include an integrated optical drive with DVD writer capability, but you 
would like to create DVD recovery media, you can use an external optical drive (purchased 
separately) to create recovery discs. If you use an external optical drive, it must be connected 
directly to a USB port on the computer; the drive cannot be connected to a USB port on an external 
device, such as a USB hub. If you cannot create DVD media yourself, you can obtain recovery discs 
for your computer from HP. See the Worldwide Telephone Numbers booklet included with 
the computer. You can also find contact information on the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

◦ Be sure that the computer is connected to AC power before you begin creating the recovery media.

◦ The creation process can take an hour or more. Do not interrupt the creation process.

◦ If necessary, you can exit the program before you have finished creating all of the recovery DVDs. 
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery 
Manager, you will be prompted to continue.

To create HP Recovery media:

IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before 
beginning these steps.

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.

2. Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 129.
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Using Windows Tools
You can create recovery media, system restore points, and backups of personal information using 
Windows tools.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see the Get started app.

▲ Select the Start button, and then select the Get started app.

Restore and recovery
There are several options for recovering your system. Choose the method that best matches your situation 
and level of expertise:

IMPORTANT: Not all methods are available on all products.

● Windows offers several options for restoring from backup, refreshing the computer, and resetting 
the computer to its original state. For more information see the Get started app.

▲ Select the Start button, and then select the Get started app.

● If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers 
and/or applications option (select products only) of HP Recovery Manager to reinstall the individual 
application or driver.

▲ Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers 
and/or applications, and then follow the on-screen instructions.

● If you want to recover the Windows partition to original factory content, you can choose the System 
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media. 
For more information, see Recovering using Recovering using HP Recovery Manager on page 129. If you 
have not already created recovery media, see Creating HP Recovery media (select products only) 
on page 127.

● On select products, if you want to recover the computer's original factory partition and content, or if you 
have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more 
information, see Recovering using HP Recovery Manager on page 129.

● On select products, if you want to remove the recovery partition to reclaim hard drive space, 
HP Recovery Manager offers the Remove Recovery Partition option.

For more information, see Removing the Removing the HP Recovery partition (select products only) 
on page 131.
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Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by using 
the HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery 
partition (select products only). If you have not already created recovery media, see Creating HP Recovery 
media (select products only) on page 127.

What you need to know before you get started

● HP Recovery Manager recovers only software that was installed at the factory. For software not 
provided with this computer, you must either download the software from the manufacturer's website 
or reinstall the software from the media provided by the manufacturer.

IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct 
computer issues.

● To use the Factory Reset option (select products only), you must use HP Recovery media. If you have 
not already created recovery media, see Creating HP Recovery media (select products only) 
on page 127.

● If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does 
not work, you can obtain recovery media for your system from support. See the Worldwide Telephone 
Numbers booklet included with the computer. You can also find contact information from 
the HP website. Go to http://www.hp.com/support, select your country or region, and follow the on-
screen instructions.

IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before 
beginning recovery, back up any personal data you want to retain.

Using HP Recovery media, you can choose from one of the following recovery options:

NOTE: Only the options available for your computer display when you start the recovery process.

● System Recovery—Reinstalls the original operating system, and then configures the settings for 
the programs that were installed at the factory.

● Factory Reset—Restores the computer to its original factory state by deleting all information from 
the hard drive and re-creating the partitions. Then it reinstalls the operating system and the software 
that was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.
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Using the HP Recovery partition (select products only)

The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a 
recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before 
beginning these steps (select products only).

1. Type recovery in the taskbar search box, select Recovery Manager, and then select 
HP Recovery Environment.

‒ or –

For computers or tablets with keyboards attached, press f11 while the computer boots, or press and 
hold f11 as you press the power button.

For tablets without keyboards:

Turn on or restart the tablet, and then quickly hold down the volume down button; then select f11.

‒ or –

Turn on or restart the tablet, and then quickly hold down the Windows button; then select f11.

2. Select Troubleshoot from the boot options menu.

3. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does 
not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the HP Recovery media, and then restart the computer.

NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer 
boot order. See Changing the computer boot order on page 131.

3. Follow the on-screen instructions.
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Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which is 
the order of devices listed in BIOS where the computer looks for startup information. You can change 
the selection to an optical drive or a USB flash drive.

To change the boot order:

IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before 
beginning these steps.

1. Insert the HP Recovery media.

2. Access BIOS:

For computers or tablets with keyboards attached:

▲ Turn on or restart the computer or tablet, quickly press esc, and then press f9 for boot options.

For tablets without keyboards:

▲ Turn on or restart the tablet, and then quickly hold down the volume down button; then select f9.

‒ or –

Turn on or restart the tablet, and then quickly hold down the Windows button; then select f9.

3. Select the optical drive or USB flash drive from which you want to boot.

4. Follow the on-screen instructions.

Removing the HP Recovery partition (select products only)

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.

IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery 
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition, 
create HP Recovery media; see Creating HP Recovery media (select products only) on page 127.

NOTE: The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.
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14 Backup and recovery – Windows 8

To protect your information, use Windows backup and restore utilities to back up individual files and folders, 
back up your entire hard drive, create system repair media (select models only) by using the installed optical 
drive (select models only) or an optional external optical drive, or create system restore points. In case of 
system failure, you can use the backup files to restore the contents of your computer.

In Windows 8, from the Start screen, type restore, click Settings, and then select from the list of displayed 
options.

- or -

In Windows 8.1, from the Start screen, type restore, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in 
HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP Support Assistant 
app.

In case of system instability, HP recommends that you print the recovery procedures and save them for later 
use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to HP Support Assistant. To access HP Support Assistant on the Start 
screen, select the HP Support Assistant app.

Backing up your information
Recovery after a system failure is as good as your most recent backup. You should create system repair 
media and your initial backup immediately after initial system setup. As you add new software and data files, 
you should continue to back up your system on a regular basis to maintain a reasonably current backup. The 
system repair media (select models only) are used to start up (boot) the computer and repair the operating 
system in case of system instability or failure. Your initial and subsequent backups allow you to restore your 
data and settings if a failure occurs.

On Start screen, type backup, click Settings, and then select Save backup copies of your files with File 
History.

You can back up your information to an optional external hard drive or a network drive.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your 
settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore in Windows 8.0:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the computer.
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1. From the Start screen, type backup, and then click Settings.

2. Click Save backup copy of your files with file history.

File History windows are launched.

3. Follow the on-screen instructions to use file history to backup files.

- or -

Click recovery to create a recovery drive using a USB flash drive.

- or -

Click Windows 7 file recovery, and then click create a system image to create a system image.

To create a backup using Backup and Restore in Windows 8.1:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the computer.

1. From the Start screen, type backup.

2. Click Save backup copy of your files with file history.

File History windows are launched.

3. Follow the on-screen instructions to use file history to backup files.

- or -

Click recovery to create a recovery drive using a USB flash drive.

- or -

Click System Image Backup to create a system image.
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Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you have 
previously backed up. You can also use Windows Automatic Repair to fix problems that might prevent 
Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The 
image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair media you 
previously created (select models only), you must purchase Windows 8 operating system media to reboot the 
computer and repair the operating system.

Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you 
have created and any software that you have installed on the computer are permanently removed. The f11 
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. 
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition: From the Start screen, type C, and 
then select Computer.

NOTE: If the Recovery Image partition is not listed, you must recover your operating system and 
programs using the Windows 8 operating system media and the Driver Recovery media (both purchased 
separately).

3. If the Recovery Image partition is listed, restart the computer, and then press esc while the “Press the 
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Choose your language.

6. Choose your keyboard layout.

7. Select Troubleshoot from the boot options menu.

8. Select Reset your PC, and follow the on-screen instructions.
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Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country or 
region, and follow the on-screen instructions. You can also order the DVD by calling support. For contact 
information, see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and reformats 
the hard drive. All files that you have created and any software that you have installed on the computer are 
permanently removed. When reformatting is complete, the recovery process helps you restore the operating 
system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive before 
the Windows operating system loads.

3. Power off the computer.

4. Power on the computer, and then press F9 to show the BIOS boot menu.

5. When the DVD is booting, select the DVD from the UEFI Boot Sources.

6. When prompted, press any keyboard key.

7. Follow the on-screen instructions.

After the installation is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows Refresh 
option allows you to start fresh and keep what is important to you.

IMPORTANT: Refresh removes any traditional applications that were not originally installed on the system 
at the factory.

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a quick way 
to see what you might need to reinstall. See HP Support Assistant for instructions on reinstalling traditional 
applications. To access HP Support Assistant on the Start screen, select the HP Support Assistant app.

NOTE: You may be prompted for your permission or password when using Refresh. See HP Support 
Assistant for more information. To access HP Support Assistant on the Start screen, select the HP Support 
Assistant app.

To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen.

4. In Windows 8.0, select General from the PC settings screen.

- or -

In Windows 8.1, select Update and Recovery , and then select Recovery.

5. Scroll the right-side choices down to display Refresh your PC without affecting your files.

6. Under Refresh your PC without affecting your files, select Get started, and follow the on-screen 
instructions.

Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove personal 
information before you give away or recycle your computer. The process described in this section provides a 
speedy, simple way to return the computer to its original state. This option removes all personal data, apps, 
and settings from your computer, and reinstalls Windows.

IMPORTANT: This option does not provide backups of your information. Before using this option, back up 
any personal information you wish to retain.

You can initiate this option by using the f11 key or from the Start screen.

To use the f11 key:

1. Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

2. Choose your language.

3. Choose your keyboard layout.

4. Select Troubleshoot from the boot options menu.

5. Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:
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1. On the Start screen, point to the far-right upper or lower corner of the screen to display the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen.

4. In Windows 8.0, select General from the PC settings screen.

- or -

In Windows 8.1, select Update and Recovery , and then select Recovery.

5. Scroll the right-side choices down to display Remove everything and reinstall Windows.

6. Under Remove everything and reinstall Windows, select Get started, and follow the on-screen 
instructions.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted from 
the system.

1. From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
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15 Backup and recovery – Windows 7

Your computer includes HP and Windows tools to help you safeguard your information and retrieve it if you 
ever need to. These tools will help you return your computer to a proper working state, all with simple steps. 
This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create HP Recovery media. This step creates a Windows 7 
operating system DVD and a Driver Recovery DVD. The Windows DVD can be used to reinstall the original 
operating system in cases where the hard drive is corrupted or has been replaced. The Driver Recovery 
DVD installs specific drivers and applications. See Creating recovery media with HP Recovery Disc 
Creator on page 139.

2. Use Windows Backup and Recovery tools to perform the following:

● Back up individual files and folders

● Back up your entire hard drive (select models only)

● Create system repair discs (select models only) with the installed optical drive (select models only) 
or an optional external optical drive

● Create system restore points

NOTE: This guide describes an overview of backing up, restoring, and recovering options. For more details 
about the tools provided, see Help and Support. To access Help and Support, select Start > Help and 
Support.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of 
system instability.

In case of system failure, you can use the backup files to restore the contents of your computer. See Backing 
up your information on page 140.
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Guidelines

● When creating recovery media or backing up to discs, use any of the following types of discs (purchased 
separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the 
type of optical drive you are using.

● Be sure that the computer is connected to AC power before you start the recovery media creation 
process or the backup process.

Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery media. 
After you successfully set up the computer, you can create recovery media using HP Recovery Disc Creator. 
This recovery media allows you to reinstall your original operating system as well as select drivers and 
applications if the hard drive becomes corrupted. HP Recovery Disc Creator can create two kinds of recovery 
DVDs:

● Windows 7 operating system DVD—Installs the operating system without additional drivers or 
applications.

● Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP 
Software Setup utility installs drivers and applications.

Creating recovery media

NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to create that 
media will not be available after you create a Windows DVD.

To create the Windows DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Windows disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process. Label the disc after you create it, and store it in a 
secure place.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process. Label the disc after you create it, and store it in a 
secure place.
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Backing up your information

You should create system repair media and your initial backup immediately after initial system setup. As you 
add new software and data files, you should continue to back up your system on a regular basis to maintain a 
reasonably current backup. You should also create Windows system repair media (select models only) which 
can be used to start up (boot) the computer and repair the operating system in case of system instability or 
failure. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated directories.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your 
settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in 
Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: Windows includes the User Account Control feature to improve the security of your computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and 
Support.

To create a backup using Windows Backup and Restore:

NOTE: The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models only), or 
create system repair media (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you have 
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent 
Windows from starting correctly.

●
f11 recovery tools (select models only): You can use the f11 recovery tools to recover your original hard 
drive image. The image includes the Windows operating system and software programs installed at the 
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair media you 
previously created (select models only), you must purchase Windows 7 operating system media to reboot the 
computer and repair the operating system.
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Using the Windows recovery tools 

Using the Windows recovery tools, you can:

● Recover individual files

● Restore the computer to a previous system restore point

● Recover information using recovery tools

NOTE: For detailed instructions on various recovery and restore options, perform a search for these topics 
in Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: Windows includes the User Account Control feature to improve the security of your computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and 
Support.

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models only), 
or your files.

To recover your information using Startup Repair, follow these steps:

CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files you have 
created and any software installed on the computer are permanently removed. When reformatting is 
complete, the recovery process restores the operating system, as well as the drivers, software, and utilities 
from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition and the Windows partition.

To check for the Windows partition, select Start > Computer.

NOTE: If the Windows partition and the Recovery Image partition is not listed, you must recover your 
operating system and programs using the Windows 7 operating system DVD and the Driver Recovery 
media. 

3. If the Windows partition is listed, restart the computer, and then press f8 before the Windows operating 
system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, select Start > Help 
and Support.
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Using f11 recovery tools (select models only)

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you 
have created and any software that you have installed on the computer are permanently removed. The f11 
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. 
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition: click Start, right-click Computer, 
click Manage, and then click Disk Management.

NOTE: If the Recovery Image partition is not listed, you must recover your operating system and 
programs using the Windows 7 operating system media and the Driver Recovery media. 

3. If the Recovery Image partition is listed, restart the computer, and then press esc while the “Press the 
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 7 operating system media

If you cannot use the recovery media you previously created using the HP Recovery Disc Creator (select 
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the 
operating system.

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to 
http://www.hp.com/support. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the 
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and reformats 
the hard drive. All files that you have created and any software that you have installed on the computer are 
permanently removed. When reformatting is complete, the recovery process helps you restore the operating 
system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before 
the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Install now.

7. Follow the on-screen instructions.
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After the installation is completed:

1. Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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16 Backup and Recovery – SUSE Linux

Recovery after a system failure is as good as your most recent backup. As you add new software and data 
files, you should continue to back up your system on a regular basis to maintain a reasonably current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if ever 
needed.

Creating backups
1. Create restore media immediately after you set up the computer.

2. As you add files, routinely create a backup of your system and personal information.

Creating restore media
You can create an HP Factory Image, using an installed or an external DVD±RW optical drive or a USB drive. 
The HP Factory Image can be used to perform system recovery in the event of a system failure. The recovery 
tool reinstalls the original operating system and HP programs and drivers that were installed at the factory.

To create the restore media:

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image in the right pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

NOTE: The image produced by HP Create Factory Image can be written to a USB disk on key or a DVD. 
If you are writing to a DVD, follow the on-screen instructions. To write the image to a USB disk on key:

To write the image to a USB disk on key:

a. Insert the USB disk on key in a USB port.

b. To transfer the image to a USB disk on key, use the dd command.

Backing up your information
You should back up your computer files on a regular schedule to maintain a current backup. You can 
manually back up your information to an optional external drive, a network drive, or discs. Back up your 
system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click Backup my home 
directory.

2. Click Storage Destination Location, and then select a location to back up your information.
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3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save the 
backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.

4. To restore all files from the selected location, click Restore all files. To restore select files only, click 
Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

NOTE: If multiple backups have been performed, click Use the latest version to restore the latest 
version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery
Recovery allows you to repair or restore the computer to its original factory state.

CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All files you 
have created and any software installed on the computer are permanently removed. The recovery tool 
reinstalls the original operating system and HP programs and drivers that were installed at the factory. 
Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files must be 
restored from a backup.

To restore the computer using the HP Factory Image, you must first create the recovery media. If you have 
not already created it, see Creating restore media on page 144.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image into the optical drive or insert the USB disk on key into the USB port, and 
restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu and select the 
option for the optical drive, if you are using a DVD to restore. If you are using a USB disk to key, select 
USB disk on key.

4. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot menu, and 
then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-Restore?

6. Follow the on-screen instructions.

NOTE: The image produced by the Create Factory Image utility may be written to either a USB disk on a key 
or a DVD. To write the image to a disk, use the dd command to transfer the image to a USB disk on a key. The 
USB disk on a key may be inserted in a USB port. 
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Remove everything and reinstall SLED
Sometimes you want to perform detailed reformatting of your computer, or you want to remove personal 
information before you give away or recycle your computer. The process described in this section provides a 
speedy, simple way to return the computer to its original state. This option removes all personal data, 
applications, and settings from your computer, and reinstalls the Linux operating system.

IMPORTANT: This option does not provide backups of your information. Before using this option, back up 
any personal information you wish to retain.

You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

The following options are available:

● Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

● Recover/Repair System—This option repairs a system that is not working properly and preserves user 
data.

● Restore Factory System—This option restores the system back to the original factory state. User data is 
not preserved.

Select an option and follow the on-screen instructions.
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17 Statement of memory volatility

The purpose of this chapter is to provide general information regarding nonvolatile memory in HP Business 
Notebook PCs. This chapter also provides general instructions for restoring nonvolatile memory that can 
contain personal data after the system has been powered off and the hard drive has been removed.

HP Business Notebook PC products that use Intel®-based or AMD®-based system boards contain volatile DDR 
memory. The amount of nonvolatile memory present in the system depends upon the system configuration. 
Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally 
shipped from HP, assuming that no subsequent modifications have been made to the system and assuming 
that no applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC system, 
personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain 
in nonvolatile memory. Use the steps below to remove personal data from the notebook PC, including the 
nonvolatile memory found in Intel-based and AMD-based system boards.

NOTE: If your tablet has a keyboard base, connect to the keyboard base before beginning steps in this 
chapter.

1. Follow steps (a) through (j) below to restore the nonvolatile memory that can contain personal data. 
Restoring or reprogramming nonvolatile memory that does not store personal data is neither necessary 
nor recommended.

a. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup 
Menu” message is displayed at the bottom of the screen.

NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

b. Select Main, select Restore Defaults, and then select Yes to load defaults.

c. Select the Security menu, select Restore Security Level Defaults, and then select Yes to restore 
security level defaults.

d. If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities menu. 
Select System IDs, and then select Asset Tracking Number. Clear the tag, and then make the 
selection to return to the prior menu.

e. If a DriveLock password is set, select the Security menu, and scroll down to Hard Drive Tools 
under the Utilities menu. Select Hard Drive Tools, select DriveLock, then uncheck the checkbox 
for DriveLock password on restart. Select OK to proceed.

f. If an Automatic DriveLock password is set, select the Security menu, scroll down to Hard Drive 
Tools under the Utilities menu. Select Hard Drive Tools, scroll down to Automatic DriveLock, 
then select the desired hard drive and disable protection. At the automatic drive lock warning 
screen, select Yes to continue. Repeat this procedure if more than one hard drive has an Automatic 
DriveLock password.

g. Select the Main menu, and then select Reset BIOS Security to factory default. Click Yes at the 
warning message.

h. Select the Main menu, select Save Changes and Exit, select Yes to save changes and exit, and 
then select Shutdown.
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i. Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint reader, 
one or two prompts will appear—one to clear the TPM and the other to Reset Fingerprint Sensor; 
press or tap F1 to accept or F2 to reject.

j. Remove all power and system batteries for at least 24 hours.

2. Complete one of the following:

● Remove and retain the storage drive.

– or –

● Clear the drive contents by using a third party utility designed to erase data from an SSD.

– or –

● Clear the contents of the drive by using the following BIOS Setup Secure Erase command option 
steps:

IMPORTANT: If you clear data using Secure Erase, it cannot be recovered.

a. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup 
Menu” message is displayed at the bottom of the screen.

b. Select the Security menu and scroll down to the Utilities menu.

c. Select Hard Drive Tools.

d. Under Utilities, select Secure Erase, select the hard drive storing the data you want to clear, and 
then follow the on-screen instructions to continue.

– or –

● Clear the contents of the drive by using the following Disk Sanitizer command steps:

IMPORTANT: If you clear data using Disk Sanitizer, it cannot be recovered.

NOTE: The amount of time it takes for Disk Sanitizer to run can take several hours. Plug the 
computer into an AC outlet before starting.

a. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup 
Menu” message is displayed at the bottom of the screen.

b. Select the Security menu and scroll down to the Utilities menu.

c. Select Hard Drive Tools.

d. Under Utilities, select Disk Sanitizer, select the hard drive holding the data you want to clear, and 
then follow the on-screen instructions to continue.

Nonvolatile memory usage

Non Volatile 
Memory Type

Amount (Size) Does this 
memory 
store 
customer 
data?

Does this 
memory 
retain data 
when power 
is removed?

What is the 
purpose of this 
memory?

How is data input into this 
memory?

How is this memory write 
protected?

HP Sure Start 
flash (select 
models only)

2 MBytes No Yes Provides 
protected 
backup of 
critical System 
BIOS code, EC 

Data cannot be written to this 
device via the host processor. 
The content is managed 
solely by the HP Sure Start 
Embedded Controller.

This memory is protected 
by the HP Sure Start 
Embedded Controller.
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Non Volatile 
Memory Type

Amount (Size) Does this 
memory 
store 
customer 
data?

Does this 
memory 
retain data 
when power 
is removed?

What is the 
purpose of this 
memory?

How is data input into this 
memory?

How is this memory write 
protected?

firmware, and 
critical PC 
configuration 
data for select 
platforms that 
support HP 
Sure Start.

Real Time Clock 
(RTC) battery 
backed-up CMOS 
configuration 
memory (CMOS)

256 bytes No Yes Stores system 
date and time 
and noncritical 
data.

RTC battery backed-up CMOS 
is programmed using the 
Computer Setup (BIOS), or 
changing the Microsoft 
Windows date & time.

This memory is not write-
protected.

Controller (NIC) 
EEPROM

64 KBytes 
(not customer 
accessible)

No Yes Store NIC 
configuration 
and NIC 
firmware.

NIC EEPROM is programmed 
using a utility from the NIC 
vendor that can be run from 
DOS.

A utility is required to 
write data to this memory 
and is available from NIC 
vendor. Writing data to 
this ROM in an 
inappropriate manner will 
render the NIC non-
functional.

DIMM Serial 
Presence Detect 
(SPD) 
configuration data

256 bytes per 
memory 
module, 128 
bytes 
programmabl
e (not 
customer 
accessible)

No Yes Stores memory 
module 
information.

DIMM SPD is programmed by 
the memory vendor.

Data cannot be written to 
this memory when the 
module is installed in a 
PC. The specific write-
protection method varies 
by memory vendor.

System BIOS 4 to 5 MBytes Yes Yes Store system 
BIOS code and 
PC 
configuration 
data.

System BIOS code is 
programmed at the factory. 
Code is updated when the 
system BIOS is updated. 
Configuration data and 
settings are input using the 
Computer Setup (BIOS) or a 
custom utility.

A utility is required for 
writing data to this 
memory and is available 
on the HP website; go to 
http://www.hp.com/
support, and select your 
country. Select Drivers & 
Downloads, and then 
follow the on-screen 
instructions.

NOTE: Writing data to 
this ROM in an 
inappropriate manner can 
render the PC non-
functional.

Intel Management 
Engine Firmware 
(present in only 
specific ZBook and 
EliteBook models. 
For more 
information, go to 
http://www.hp.com/
support, and 
select your 
country. Select 

1.5 MBytes or 
5 MBytes

Yes Yes Stores 
Management 
Engine Code, 
Settings, 
Provisioning 
Data and iAMT 
third-party data 
store.

Management Engine Code is 
programmed at the factory. 
Code is updated via Intel 
secure firmware update 
utility. Unique Provisioning 
Data can be entered at the 
factory or by an administrator 
using the Management Engine 
(MEBx) setup utility. The third 
party data store contents can 
be populated by a remote 

The Intel chipset is 
configured to enforce 
hardware protection to 
block all direct read/write 
access to this area. An 
Intel utility is required for 
updating the firmware. 
Only firmware updates 
digitally signed by Intel 
can be applied using this 
utility.
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Non Volatile 
Memory Type

Amount (Size) Does this 
memory 
store 
customer 
data?

Does this 
memory 
retain data 
when power 
is removed?

What is the 
purpose of this 
memory?

How is data input into this 
memory?

How is this memory write 
protected?

Drivers & 
Downloads, and 
then follow the 
on-screen 
instructions.)

management console or local 
applications that have been 
registered by an 
administrator to have access 
to the space.

Bluetooth flash 2Mbit No Yes Stores 
Bluetooth 
configuration 
and firmware.

Bluetooth flash is 
programmed at the factory. 
Tools for writing data to this 
memory are not publicly 
available but can be obtained 
from the silicon vendor.

A utility is required for 
writing data to this 
memory and is made 
available through newer 
versions of the driver 
whenever the flash 
requires an upgrade.

802.11 WLAN 
EEPROM

4 Kbit to 8 
Kbit

No Yes Stores 
configuration 
and calibration 
data.

802.11 WLAN EEPROM is 
programmed at the factory. 
Tools for writing data to this 
memory are not made public.

A utility is required for 
writing data to this 
memory and is typically 
not made available to the 
public unless a firmware 
upgrade is necessary to 
address a unique issue.

Webcam 64K bit No Yes Store webcam 
configuration 
and firmware.

Webcam memory is 
programmed using a utility 
from the device manufacturer 
that can be run from 
Windows.

A utility is required for 
writing data to this 
memory and is typically 
not made available to the 
public unless a firmware 
upgrade is necessary to 
address a unique issue.

Fingerprint 
Reader

512 KByte 
flash

Yes Yes Stores 
fingerprint 
templates.

Fingerprint reader memory is 
programmed by user 
enrollment in HP ProtectTools 
Security Manager.

Only a digitally signed 
application can make the 
call to write to the flash.

Questions and answers
1. How can the BIOS settings be restored (returned to factory settings)?

IMPORTANT: Restore defaults does not securely erase any data on your hard drive. See question and 
answer 6 for steps to securely erase data.

Restore defaults does not reset the Customer Secure Boot key. See question and answer 7 for 
information about resetting the key.
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a. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup 
Menu” message is displayed at the bottom of the screen.

b. Select Main, and then select Restore defaults.

The Unified Extensible Firmware Interface (UEFI) BIOS an industry-standard software interface 
between the platform firmware and an operating system (OS). It is a replacement for the older 
BIOS architecture, but supports much of the legacy BIOS functionality.

Like the legacy BIOS, the UEFI BIOS provides an interface display the system information, 
configuration settings, and change the configuration of your computer before an OS is loaded. 
BIOS is provides a secure run-time environment that supports a Graphic User Interface (GUI). In 
this environment, you can use either a pointing device (Touchscreen, TouchPad, pointing stick, or 
USB mouse) or the keyboard to navigate and make menu and configuration selections. The UEFI 
BIOS also contains basic system diagnostics.

The UEFI BIOS provides functionality beyond that of the legacy BIOS. In addition the UEFI BIOS 
works to initialize the computer’s hardware before loading and executing the OS, the run-time 
environment allows the loading and execution of software programs from storage devices to 
provide more functionality, such as advanced hardware diagnostics (with the ability to display 
more detailed system information) and advanced firmware management and recovery software.

c. Follow the on-screen instructions.

The UEFI BIOS resides on a flash memory chip. A utility is required to write to the chip.

d. Select Main, select Save Changes and Exit, and then follow the on-screen instructions.

2. What is a UEFI BIOS, and how is it different from a legacy BIOS?

3. Where does the UEFI BIOS reside?

4. What kind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory 
module? How would this data be written?

The DIMM SPD memory contains information about the memory module, such as size, serial number, 
data width, speed/timing, voltage, and thermal information. This information is written by the module 
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is 
installed in a PC. Third-party tools do exist that can write to the EEPROM when the memory module is 
not installed in a PC. Various third-party tools are available to read SPD memory.

5. What is meant by “Restore the nonvolatile memory found in Intel-based system boards”?

This message relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC 
configuration data.

6. How can the BIOS security be reset to factory defaults and data erased?

IMPORTANT: Resetting will result in the loss of information. These steps will not reset a Customer 
Secure Boot Key.

See question and answer 7 for information about resetting the key.

a. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup 
Menu” message is displayed at the bottom of the screen.

b. Select Main, and then select Reset BIOS Security to Factory Default.
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c. Follow the on-screen instructions.

d. Select Main, select Save Changes and Exit, and then follow the on-screen instructions.

7. How can the Customer Secure Boot Key be reset?

Secure Boot is a feature to ensure that only authenticated code can start on a platform. If you enabled 
Secure Boot and created a Customer Secure Boot Key, simply disabling Secure Boot will not clear the 
keys. You must also select to clear the Secure Boot Keys. Use the same procedure you used to create 
the Secure Boot Keys, but make the selection to clear or delete all Secure Boot Keys.

Using HP Sure Start (select models only)
Select computer models are configured with HP Sure Start, a technology that continuously monitors your 
computer's BIOS for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start 
restores the BIOS to its previously safe state, without user intervention. Those select computer models ship 
with HP Sure Start configured and enabled. HP Sure Start is configured and already enabled so that most 
users can use the HP Sure Start default configuration. The default configuration can be customized by 
advanced users.

To access the latest documentation on HP Sure Start, go to http://www.hp.com/support, and select your 
country. Select Drivers & Downloads, and then follow the on-screen instructions.
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18 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120 
volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or 
region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region 
where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.0m (3.3t) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in 
the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating of 
125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet 
C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4
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Country/region Accredited agency Applicable note number

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and 
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be 
used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the 
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug must 
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
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19 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose of the 
battery in general household waste. Follow the local laws and regulations in your area for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable 
batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/
recycle.
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A
AC adapter lights 17
AC adapter, spare part numbers 35
AC adapter/battery light 14
accessory battery connector 18
antenna

location 8
audio, product description 3
audio-in jack 16
audio-out jack 16
audio/USB board

removal 84
spare part number 27, 84

B
backup 144
Backup and Restore 132, 133, 140
backup tools 138
backups

creating 140
recovering 141

base enclosure, spare part number
28

battery
removal 41
spare part numbers 28, 41

battery bay 18
battery release latch 18
BIOS

determining version 110, 117, 
123

downloading an update 110, 
117, 123

updating 110, 116, 122
Blu-ray R/RE DVD±RW SuperMulti 

Double-Layer Drive
precautions 38
spare part numbers 27, 35, 52

Blu-ray ROM DVD±RW SuperMulti 
Double-Layer Drive

spare part numbers 28, 35, 52
Bracket Kit

components 31
spare part number 31

buttons
optical drive eject 16
pointing stick 13
power 9
TouchPad 13
Touchpad on/off 13
volume mute 10
Windows 11
wireless 10

C
Cable Kit

components 32
spare part number 32

cables, service considerations 37
caps lock light 12
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35
chipset, product description 1
components

bottom 18
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rear 17
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computer major components 23
computer reset 136, 146
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navigating and selecting 108, 
115, 121

restoring default settings 109, 
116, 122

computer specifications 125
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power 17
connector, service considerations

37

D
diskette drive

precautions 38
display assembly

components 29

removal 77
spare part numbers 23, 77

display bezel
removal 62
spare part numbers 30, 62

display enclosure, spare part 
number 30

Display Hinge Kit, spare part 
number 30

display panel
product description 1
removal 64
spare part numbers 30, 64

display panel cable
illustrated 32
removal 81
spare part number 30

Display Panel Support Kit, spare part 
number 30

display switch 8
DisplayPort 15
DisplayPort-to-HDMI adapter, spare 

part number 35
docking connector 18
docking support, product 

description 4
Driver Recovery DVD,

creating 139
using for restore 142

drives, preventing damage 38
DVD-ROM Drive

precautions 38
DVD±RW and CD-RW SuperMulti 

Double-Layer combo Drive
precautions 38

DVD±RW SuperMulti Double-Layer 
Drive

spare part numbers 28, 35, 52

E
electrostatic discharge 38
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ExpressCard assembly
removal 82
spare part number 27, 82

ExpressCard bezel
illustrated 33

ExpressCard slot 15
external media cards, product 

description 4

F
f11 recovery 134, 142
fingerprint reader

location 10
removal 74
spare part numbers 74

fingerprint reader bezel
illustrated 33

fingerprint reader board 26
fingerprint reader bracket

illustrated 31
fn key 11
function keys 11

G
graphics board

removal 94
spare part numbers 26, 94
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removal 91
spare part numbers 28, 91

graphics, product description 1
grounding equipment and methods

40

H
hard drive

precautions 38
product description 2
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Hard Drive Hardware Kit
contents 34
spare part number 34

hard drive light 14
hard drive recovery 134, 142
headphone jack 16
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removal 80
spare part number 30, 81

hinge cover
removal 78
spare part number 79

HP Recovery Disc Creator, using
139

HP Recovery partition
checking for presence 142
using for recovery 142

J
jacks

audio-in 16
audio-out 16
headphone 16
microphone 16
network 17
RJ-45 17

K
keyboard

product description 4
removal 57
spare part numbers 24, 25, 57

keys
esc 11
fn 11
function 11
num lk 11
Windows 11

L
l-voltage differential signalling board

spare part number 30
legacy support, USB 108, 115, 121
lights

AC adapter 17
AC adapter/battery 14
caps lock 12
hard drive 14
microphone mute 12
mute 12
num lock 12
power 12, 14
TouchPad 12
webcam 8
wireless 12, 14

lock, spare part numbers 35
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board cable
illustrated 32

M
mass storage device

components 34
spare part number 34

memory card reader 16
memory module

product description 1, 2
removal 56, 60
spare part numbers 26, 56, 60

microphone 8
product description 3

microphone jack 16
microphone module

spare part number 30, 66
microphone mute light 12
model name 1
model number 21
mouse, spare part number 35
multifunction board

removal 71
spare part number 26, 71

mute light 12
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network jack 17
num lk key 11
num lock light 12
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operating system, product 

description 5, 6
optical drive

location 16
precautions 38
product description 3
removal 52
spare part numbers 27, 35, 52

optical drive eject button 16

P
packing guidelines 39
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components 33
spare part number 33

pointing device
product description 4

pointing stick 13
pointing stick button 13
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ports
DisplayPort 15
product description 4
Thunderbolt 15
USB 2.0 15
USB 3.0 16

power button 9
power button board

removal 75
spare part number 26, 75

power connector 17
power connector bracket

removal 96
spare part number 96

power connector cable
illustrated 32, 33
removal 96
spare part number 96

power connector/security lock 
bracket

illustrated 31
power cord

set requirements 153
spare part numbers 35

power light 12, 14
power requirements, product 

description 4, 5
processor

product description 1
removal 89
spare part numbers 26, 89

processor heat sink
removal 86
spare part numbers 28, 86

product description
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docking support 4
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external media cards 4
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hard drives 2
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optical drives 3
pointing devices 4
ports 4

power requirements 4, 5
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product name 1
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serviceability 6
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product number 21
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rear corner cover

illustrated 33
removal 96, 98
spare part number 96, 98

recovery 136, 144
recovery media, creating 139
recovery media, using for restore

142
recovery partition 134, 142
recovery tools 138
recovery tools, Windows 141
recovery, system 140
recycle

computer 136
refresh 136
removal/replacement

preliminaries 37
procedures 41, 62

remove everything and reinstall 
Windows 136

reset
computer 136, 146
steps 136, 146

restoring the hard drive 134, 142
RJ-45 bracket
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RJ-45 connector bracket

removal 98
spare part number 99

RJ-45 jack 17
RTC battery

removal 51
spare part number 28, 51

S
Screw Kit, spare part number 36
SD Card reader bezel

illustrated 33

security cable slot 15
security, product description 5
serial number 20
service considerations 37
service cover

location 18
removal 43
spare part number 28, 43

service cover release latch 18
service cover release lock 18
serviceability, product description

6
setup utility

navigating and selecting 108, 
115

restoring default settings 109, 
116

SIM card, removal 42
SIM slot 18
SIM slot, identifying 18
SLED

remove everything and reinstall 
option 146

slots
ExpressCard 15
security cable 15
SIM 18
smart card 15

Smart Card reader
removal 83
spare part number 27, 83

smart card slot 15
solid-state drive

precautions 38
product description 2
removal 46
spare part numbers 27, 34, 46

speakers
location 10
removal 73
spare part number 27, 73

specifications
computer 125

Startup Repair, using 141
static-shielding materials 40
system board

removal 97
spare part numbers 26, 97

System Diagnostics 114
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Thunderbolt port 15
tools required 37
top cover

removal 67
spare part number 26, 67

TouchPad button 13
TouchPad light 12
TouchPad on/off button 13
TouchPad zone 13
transporting guidelines 39

U
Upgrade Bay hard drive carrier

removal 54
spare part number 28, 35, 54

USB 2.0 port 15
USB 3.0 charging port 15
USB 3.0 port 16
USB legacy support 108, 115, 121

V
vents 15, 17, 18
video, product description 3
volume mute button 10

W
warrenty period 21
webcam 8

location 8
webcam light 8
webcam/microphone module

removal 66
spare part number 30, 66

Windows
Refresh 136
reinstall 136
remove everything and reinstall 

option 136
reset 136

Windows 7 operating system DVD
creating 139
using for restore 142

Windows 7 operating system media
creating 139
using for restore 142

Windows 8 operating system DVD
135

Windows button 11
Windows key 11
Windows Startup Repair, using 141

wireless
product description 3, 4

wireless antenna
location 8

wireless button 10
wireless light 12, 14
WLAN module

removal 47
spare part numbers 27, 47

workstation guidelines 39
WWAN module

removal 49
spare part numbers 27, 49
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